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Welcome to QuickBooks  
Ease-of-use is central to the QuickBooks approach to business accounting. Whether 
you are a new-to-the-world start up, or an established enterprise showing solid 
growth, you can rely on QuickBooks to help make the financial aspects simpler and 
less time consuming.

Use this Getting Started Guide to get up and running as fast as possible in 
QuickBooks. In this guide, you’ll learn

• How to install QuickBooks and set up your company file
• Important QuickBooks terms and concepts
• How to get around QuickBooks
• Where to look for help when you have questions
• How to perform some essential tasks
• How to set up QuickBooks to automatically track VAT
• How to set up payroll in QuickBooks

Note: Since this guide covers multiple editions of QuickBooks, the name “QuickBooks” is used to 
refer to any of these editions. 

Once you understand the basic concepts of QuickBooks, use the QuickBooks User 
Guide to get more comprehensive instructions on using your software. You can find 
the User Guide by going to the Help menu and selecting QuickBooks Guides, then 
User Guide.

How to Use This Guide

Use this quick reference to find the information you want.

To Go to Page

Verify that your computer meets the necessary system requirements 4

Install QuickBooks 7

Review the “Getting Started” checklist 12

Create and set up your company file 13

Learn how to get help if you have questions 23

Learn about essential QuickBooks tasks 31

Learn about VAT 47

Learn how set up payroll in QuickBooks 51
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Installing and Setting Up QuickBooks  

This chapter describes how to install and set up your new software.

Hardware and Software Requirements

Before installing your software, it is necessary to ensure that your hardware and 
software meets the requirements for QuickBooks’. (Hardware refers to your computer 
equipment and software refers to computer programmes.)

Computer equipment
Minimum requirements
• IBM compatible 200 MHz Pentium computer 
• 64 MB of RAM

Recommended requirements
• IBM compatible 350 MHz Pentium II computer 
• 96 MB of RAM

What’s the difference between the minimum and recommended requirements?  
Technically, QuickBooks will run on the minimum computer requirements. It may not 
be as fast as you would like, but if you don't have much other software on your 
computer, QuickBooks may work just fine. 

Another consideration when looking at computer requirements is the amount of data 
you are going to be entering into QuickBooks. For example, if you write an average of 
50 invoices and 30 cheques a day, have many employees, or a large list of stock 
items, QuickBooks will probably not operate as quickly as you would like with the 
minimum computer requirements. If this is the case, your computer should meet the 
recommended requirements. Using QuickBooks on the recommended computer 
ensures that your software will run at optimal levels.

Disk space requirements
• QuickBooks Regular: 350 MB of free disk space
• QuickBooks Pro: 350 MB of free disk space
• QuickBooks Accountant: 400 MB of free disk space
• 70 MB for Microsoft Internet Explorer 6.0, provided on QuickBooks CD
• 9 MB for Timer (available for QuickBooks Pro and Accountant)

Additional hardware and software
• Windows 98 (SE), Me, 2000, or XP operating system
• 2x CD-ROM drive
• 256-color SVGA monitor with a resolution of 800 x 600 (using Small Fonts in your 

Windows Control Panel Display settings)
• A sound card if you want to use the sound features
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Integration/compatibility requirements
QuickBooks is compatible with the following products, which are each 
sold separately.

• If you plan to use features that integrate with Microsoft® Word or 
Microsoft Excel (such as Write Letters or exporting reports), you 
need Microsoft® Word 97, 2000, 2002, or 2003 or Microsoft® Excel 
97, 2000, 2002, or 2003. (More RAM enhances the use of these 
features.)

• If you want to synchronise with contact management software, you 
need either:
• Microsoft® Outlook 97, 98, 2000, or 2002

or
• Symantec ACT! version 3.08, 4.02, or Interact 2000

• Compatible with Customer Manager
• Business Planner functionality requires Adobe Acrobat 5.0 or 6.0
• Payroll and online features/services require Internet access with at 

least a 56 Kbps connection speed

Multi-user installation requirements
QuickBooks Pro and Accountant allow you to have up to five users 
access QuickBooks files on a network at the same time. 

In a multi-user environment, each user must:

• Install the same version year and maintenance release of 
QuickBooks on his or her computer. For example, all users must 
have QuickBooks 2006, and the same maintenance release or 
update (if one has been sent out) installed on his or her computer.

• Have a valid installation key code for each computer you want to 
install QuickBooks on. For example, if you want three people to have 
access to QuickBooks at the same time, you must purchase three 
copies of QuickBooks. The one exception to this is if you purchase a 
5-User Pack. With a 5-User Pack, each user is given the same 
installation key code. 

• Have read/write access and create/delete rights to the directory 
where the company file is stored.

• Ensure that all the computers you want to use in a multi-user 
environment are networked properly. (Refer to the documentation 
that came with your networking product.)

Note: The number of users who can access the company file at the same 
time is not necessarily equal to the number of licences you purchase. For 
example, if you purchase a 5-User Pack and an additional licence for a sixth 
person in your office, only 5 of the 6 users can access the company file at 
the same time.
Did You Know?

Installing from a server

If your QuickBooks CD is 
mounted on a server or a 
shared CD-ROM drive, you can 
install from the CD to your own 
computer, but you cannot 
install from the CD to a remote 
computer.
Choose a location for your 
company file that all 
computers that need to use 
QuickBooks can access. You 
might want to put the company 
file on the computer of the 
person who most frequently 
uses QuickBooks. This 
enables that person to have 
the fastest access to the 
company file.

Improving performance 

in multi-user mode

To improve QuickBooks 
performance in multi-user 
mode, consider these tips:
• Store company files on the 

fastest or most powerful 
computer, preferably a 
dedicated server.

• Run reports during off 
hours.

• Refresh reports only when 
you’re ready to use or print 
them.

• Avoid keeping unnecessary 
QuickBooks windows or 
other applications open.

• Keep your company file 
size as small as possible. 
For example, you could 
minimise the number of 
items in lists, delete 
unused accounts, and 
periodically condense your 
company file.
5
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For peer-to-peer network users

To run QuickBooks in a peer-to-peer network environment, you must have Windows 
98 (SE), 2000, Me or XP.

In a peer-to-peer network, each 
computer has its own copy of 
QuickBooks installed; however, the 
QuickBooks company file is located 
on only one computer, which must 
be left on.

Peer-to-peer networks do not use a 
dedicated file server, so a single, 
dedicated machine is not required 
for computers to share files. Thus, 
all the networked computers have 
the option to share their resources.

Note: Windows XP users must have at least Standard user rights, and Windows 2000 users 
must have Power Users Group rights in order to write to the registry keys and be able to run 
QuickBooks.

For client-server network users

To run QuickBooks in a client-server network environment, you must have Windows 
2000 Server or Windows Server 2003.

Client-server networks are 
networks in which at least one 
computer is dedicated to 
sharing files, printers, or other 
resources. This computer is 
usually not used by individuals 
to do their daily work.

For example, there might be 
three computers for three 
individual users and one file 
server. In a client-server 
network, you will most likely put 
the company file on the server 
in a location accessible by all 
computers that need to use 
QuickBooks. Because all three users use QuickBooks, they each need to have their 
own copy of QuickBooks installed. The file server, however, does not need to have 
QuickBooks installed on it.

QuickBooks
installed

QuickBooks
installed

QuickBooks installed and
company file located here
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Installing QuickBooks

To install QuickBooks:

Shut down all running programs, including virus protection programs.

Insert the QuickBooks CD in your computer’s CD-ROM drive. The 
Installation Wizard prompts you to install QuickBooks. Click Yes.

Note: If the installer does not start automatically, click Start in the 
Windows taskbar, then choose Run. Type D:\setup.exe (where “D” is the 
CD-ROM drive letter). Click OK.

Type in your installation key code, and click Next.

Where can I find my installation key code? Each copy of QuickBooks 
has a unique key code number which is needed to install the 
software. The location of your key code depends on how you 
purchased QuickBooks. Refer to the table below to locate the code.

Follow the on-screen instructions to complete the installation.

Once QuickBooks is installed, you can start QuickBooks by double-
clicking the QuickBooks icon on the desktop, or by choosing 
QuickBooks from the Programs group on the Windows Start menu.

What do I do if I’m upgrading?

If you are upgrading from QuickBooks 2004 or later, you don’t need to 
do anything more. You are ready to use your new software. 

If you are upgrading from QuickBooks 2003 or earlier, you must update 
your company file after installing QuickBooks 2006. For instructions on 
how to update your company file, refer to the in-product help. In the 
Follow-Me Help, go to the Find window and search for “Updating 
Company Files”.

If you purchased QuickBooks...
the installation key code is 
located...

in a retail store on the Installation CD

by calling Intuit directly on the invoice, in an e-mail (if you 
provided one to the sales person), 
and is given over the phone

from our Web site
on the receipt that came with your 
software

Tip  After you have installed QuickBooks, write down your installation 
key code in the space provided on the inside of the front cover. You will 
need your key code if you have to re-install.
Did You Know?

Back up your previous 

accounting system

If you have an existing 
business, make sure that 
you’ve backed up your financial 
records from your previous 
accounting system. The HMRC 
requires you to keep this 
information for three years. 
You should also keep any 
software and hardware that 
your previous accounting 
system used, or have printouts 
of all the information and 
accounting reports.

Record your password in 

a safe place

Be sure to write down and 
save your administrator 
password in a secure place. 
Passwords not only protect 
your company data, but are 
also required to access your 
company file if you upgrade 
your version of QuickBooks. 
Furthermore, to have a 
forgotten password removed 
from a file, you must send the 
file to Intuit. This process 
takes several days and costs 
money.

Passwords are case 

sensitive

Keep in mind that passwords 
are case sensitive in 
QuickBooks 2004 and later. 
When adding or editing a user 
password, check the Caps 
Lock and Num Lock keys. If 
you mistype the password, you 
will not be able to access the 
company data.

Troubleshoot error 

messages

If you receive an error 
message during installation, 
and rebooting your system 
does not resolve the problem, 
you can search for the error 
message on the QuickBooks 
support site at:
exceed.quickbooks.co.uk/
7
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Setting up a multi-user environment

To set up a multi-user environment and add new users:

Make sure you have your computers properly networked. Refer to your networking 
software documentation for instructions.

Install QuickBooks on each computer, as described in “Installing QuickBooks”. 
You must use the same version of QuickBooks on each computer that you want to 
use in your multi-user environment. 

Get your QuickBooks Administrator to add and set up each user. The 
Administrator defines which features each user can access.

a. From the Company menu, choose Set Up Users.
b. Click Add User.
c. Assign a user name and case-sensitive password and click Next.
d. Follow the on-screen instructions to define the access permissions for the user.

Activate each copy of QuickBooks, as described in “Activating QuickBooks” on 
page 18.

As your business grows, you might need to add more computers to your network. For 
each new computer, you will need to install and activate a new copy of QuickBooks.

Why are passwords important?

Passwords limit access to your company file. To open a password-protected file, each 
person must enter his or her user name and a unique secret password. Defining 
users and passwords help prevent unwanted people from accessing your company's 
confidential data.

By default, QuickBooks creates an Administrator user with no password that has full 
access to the company file. If you do not want others to also have full access to your 
company file, you should assign a password to the Administrator user and create 
other users with specific access permissions. By defining users and their access 
rights, you not only control who can open your company file, but also what data they 
can view and tasks they can perform.

Updating your copy of QuickBooks
From time to time, Intuit provides updates to QuickBooks that can be downloaded 
from the Internet. These updates might include new features, services, maintenance 
fixes, or new help information. You can choose to update QuickBooks automatically 
or manually.

For complete instructions on updating your software, refer to the in-product Help. Go 
the Find window and search for “Updating QuickBooks”.
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Troubleshooting

What should I do if I have trouble installing QuickBooks?

Verify that your system meets the minimum requirements listed on 
page 4.

Restart your computer.

Close all open programs, including virus protection programs:
• In Windows 98, press CTRL+ALT+DELETE to display the Close 

Program window. Close all programs except Explorer and Systray. If 
a program will not close or prompts you to reboot the computer, 
leave it open.

• In Windows 2000 or XP, select the Applications tab from the Task 
Manager (Task List) and close all open programs.

Try installing QuickBooks again.

If you need further installation assistance, contact our Customer 
Services team at 0845 606 2161, Monday to Friday, (9 a.m. – 5:30 
p.m.), or if outside the UK, +44 870 609 0601.

What should I do if I have trouble activating QuickBooks?

Make sure that you activate your software with a company file open.

Check that your computer’s system date is set properly. If the date 
is set too far ahead, QuickBooks may think that your licence is 
expired.
• To change your computer date in Windows, double-click the time 

that is displayed on your Windows Task Bar. 

Ensure the person who is activating QuickBooks has Administrator 
rights in Windows, or is a user that has full-access rights.

If you need further installation assistance, contact our Customer 
Services team at 0845 606 2161, Monday to Friday, (9 a.m. – 5:30 
p.m.), or if outside the UK, +44 870 609 0601.

What should I do if I can’t find my installation key code (IKC)?

You can find your installation key code either with one of the sources 
listed in the table on page 7 or within the software itself if you have 
installed it. Follow the steps below to find your IKC in the software.

Start QuickBooks 2006. 

From the Help menu, choose My Licence Information. Write down 
your Installation Key numbers on the inside of the front cover of this 
guide to keep for future reference.

If you are still unable to locate your installation key code, you can call 
0845 606 2161, or if outside the UK, +44 870 609 0601. We may be 
able to provide you with a replacement key code but proof of purchase 
is required. If you cannot provide proof of purchase or have misplaced 
your IKC, a fee may be charged for a replacement IKC.
Did You Know?

Using multiple company 

files

If you have more than one 
company file (i.e., you are 
tracking two different 
businesses in QuickBooks), 
you should keep those 
company files in the same 
directory. That way, when you 
update QuickBooks (via a 
software update for example), 
you will need to download the 
update files only once.

Product Information 

Window

The Product Information 
window lists information about 
your software such as the 
number of entries you have in 
your lists, the size of your 
company file, which version of 
QuickBooks you are running, 
and the location of your 
company file. You can open the 
Product Information window by 
pressing the CTRL and 1 keys, 
or pressing the F2 button.

Using a Dell computer?

When installing an update to a 
Dell computer, you may get a 
message to shut down 
QuickBooks and try again. This 
is because Dell computers 
have a support process 
running in the background and 
it is interfering with the 
QuickBooks update agent. For 
more information on this, visit 
our support site (see below), 
and search for “support.exe”.

Troubleshoot error 

messages

If you receive an error 
message during installation 
and rebooting your system 
does not resolve the 
problem, you can search for 
the error message on the 
QuickBooks support site at:
exceed.quickbooks.co.uk

Did You Know?
9



10
Why doesn’t my old administrator password work after I upgrade?

QuickBooks 2004 and later versions support case-sensitive passwords. If you 
believe you are entering the correct password, but are still getting the message “The 
password you typed is incorrect,” your password might include mixed-cased 
characters. Try the following:
• Attempt to log in by entering the login name of Admin, and then click OK without 

typing a password.
• Enter your password with Caps Lock or Num Lock turned on or off.
• Enter variations of your password, using mixed upper- and lower-case characters.
• Enter the password with a space before or after the actual password.
• Type the password in a text editor such as Microsoft® Word to confirm that your 

keyboard is functioning properly.
• Restore a pre-update backup of your file that does not have the case-sensitive 

password. When you restore this file, you can set your new administrator password 
at the end of the update process.

If you are still unable to access your file, you can call 0845 606 2161, or if outside 
the UK, +44 870 609 0601. A fee may be charged for this service depending on the 
support options of your service plan.

Can I install different versions of QuickBooks on the same computer?

Yes. You can install multiple versions of QuickBooks (for example QuickBooks 2005 
and QuickBooks 2006) on the same computer. However, you cannot run two 
instances of QuickBooks from the same version at the same time.

Can I revert to an earlier version of QuickBooks?

Yes. Uninstall the version of QuickBooks that you don’t want, and then reinstall the 
earlier version of QuickBooks. However, it is important to note that QuickBooks is not 
backwards compatible. That means that the software cannot open company files that 
have been converted to or were created with a later version. For example, a company 
file that was created in version 2006, cannot be opened in version 2005. Therefore, 
if you plan to revert to an earlier version of QuickBooks, make sure you have a recent 
backup of your company file that was created with the same version you want to 
revert to. 
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Can I install QuickBooks (single-user version) on more than one 
computer?

You can install QuickBooks (single-user version) on the computers 
used by a single individual. For example, if you bought one copy of 
QuickBooks for your office, you can install it on your home PC or laptop 
as well. This does not violate the software licence agreement as long 
as you are the only person using QuickBooks on both computers. 
However, if multiple users will be accessing QuickBooks on multiple 
computers, then you (or your company) must purchase an additional 
licenced copy for each user.

Importing/Exporting Information into 
QuickBooks

You can use the Import feature in QuickBooks to import information 
such as account details, a list of the items or products that you sell, 
and a list of your customers and suppliers. (Only list information is 
imported, and not transactions.) This could potentially save you a huge 
amount of time when setting up your company especially if you were 
using a spreadsheet program such as Microsoft® Excel. 

To be able to import data, you must format the information in an .IIF 
file. This is basically a special text file that is formatted so QuickBooks 
can understand its contents. QuickBooks Pro and Accountant can also 
import data from Microsoft® Excel.

For complete instructions on importing information into QuickBooks, 
call us at 0845 606 2161 (if within the UK), or +44 870 609 0601 (if 
outside the UK). Take advantage of the 30 days of free support from 
the time you activate your software.
Did you know?

QuickBooks backup file

The QuickBooks backup file is 
a compressed version of your 
QuickBooks company file that 
contains all transactions up to 
the date the company backup 
was made. QuickBooks 
backups have a .QBB 
extension and cannot be 
opened directly. Backups 
must be restored, using the 
Restore function located 
under the File menu.
To learn more about backing 
up your company file, refer to 
the in-product Help. In the 
Follow-me Help, go to Find 
window and search for 
“backing up your data”. For 
information on Follow-me Help, 
refer to “Using Follow-Me 
Help” on page 23.

Troubleshooting 

conversion errors

If you receive an error message 
during installation and rebooting 
your system does not resolve 
the problem, you can search for 
the error message on the 
QuickBooks support site at:
exceed.quickbooks.co.uk
11



12
Setting Up Your Company in QuickBooks

The first thing you need to do in QuickBooks is set up a company file for your 
business. Setting up your company file properly is the most important thing you can 
do to help yourself manage your business efficiently and with confidence.

The setup process is easy. Depending on the complexity of your business, setting up 
your company file can take anywhere from a few minutes to a few hours. The amount 
of time varies based on how much detail you add about your accounts, customers, 
suppliers, employees, products, and services, as well as the number of historical 
transactions you want to enter.

When you set up your company file, QuickBooks will prompt you for a number of 
details about your company. Before you begin the setup process, gather the 
information shown in the Getting Started Checklist below.

Getting Started Checklist

Company name
and address

You’ll need both the trading and legal name for your 
company. The legal company name is the name you 
use when filing the taxes for your business. The 
trading company name is the name that you want to 
appear on invoices, statements, reports, etc. 

Start Date

QuickBooks uses a start date as the point at which 
you begin entering your business transactions. You 
must enter all historical transactions between your 
start date and today to ensure complete accounting 
records for your business.

The start date is the first day AFTER which you have 
gathered all your information. For example, if your year 

end if 31st March 2005, your QuickBooks start date is 
1 April 2005. You need all the information up to and 

including the 31st March 2005.

VAT Registration 
No.

A VAT registration number that is issued to you by the 
HM Revenue & Customs once you register for VAT. 

VAT Information

You need to know the VAT scheme you are registered 
for: either the Accruals (Standard) VAT scheme or 
Cash VAT Accounting scheme. Check with your 
accountant if you are not sure. You will also need 
opening balance figures including amount of VAT owed 
to HMRC.

PAYE Tax 
Reference No.

If you have employees to pay, you need to register 
with the HM Revenue & Customs (previously called 
Inland Revenue) and obtain a tax reference number. 
This number can be found on the yellow payslip 
booklets (P30BC) issued by HMRC.
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Set up your company file
After you have gathered the company information listed in the Getting 
Started Checklist, you can set up your business in QuickBooks using 
the EasyStep Interview. The EasyStep Interview walks you through the 
setup procedure and helps you tailor QuickBooks for your business. 

The setup interview is divided into six sections. After you have 
completed these sections, QuickBooks has all the basic information it 
needs to set up your company file. 

You can leave the EasyStep Interview at any time and QuickBooks will 
remember where you left off. To return to the EasyStep Interview, go to 
the File menu and choose EasyStep Interview.

PAYE Liability
If you are operating payroll, you need to know how 
much PAYE income tax and National Insurance (NI) 
contributions you owe to HMRC as of your start date.

Bank Statements, 
Credit Card 
Accounts, and 
Outstanding 
Cheques

You need to have your latest bank statement balances 
and information about any outstanding cheques, 
deposits, withdrawals, or charges to all of the 
accounts you want to set up and manage in 
QuickBooks, including credit cards, bank accounts, 
and loans.

Assets and 
Liabilities

You will need the balance of each loan your business 
owes (liabilities) such as a bank loan, hire purchase, 
or director’s loan; or is owed (assets). If you have 
stock, you need to know its value as of your start 
date.

Fixed Assets

If your business has fixed assets such as office 
equipment, plant equipment, vehicles etc., you need 
to know the total ‘net book value’ (NBV) of each type 
of asset. This is either stated on your last set of 
accounts or you can obtain it from your accountant.

Optional 
Information

Eventually, you will need to enter detailed information 
about your customers, suppliers, and employees, as 
well as the products and services you sell, the 
products that you hold in stock, and any additional 
current assets.

Getting Started Checklist (Continued)

Key Terms

Company file

The company file is the data 
file that QuickBooks uses to 
store and manage all the 
information and financial 
transactions for your business. 
QuickBooks company files 
have the extension .QBW.

Historical transactions

A list of all business 
transactions that happened 
before your start date. In 
QuickBooks, you can have 
many different lists of 
historical transactions, 
including:
• Invoices
• Customer payments
• Deposits
• Credit Notes
• Sales Receipts
• Bills
• Payments to suppliers
• Credits with suppliers
• Item receipts
• Journal entries
• Purchase orders

Assets

Company assets are the things 
that your company owns. 
QuickBooks distinguishes 
between two types of assets:

Current assets: assets that 
you are likely to convert to 
cash within one year (such 
as the cash you have on 
hand, the money in your 
current and deposit bank 
accounts, and the money 
your customers owe you).

Fixed assets: assets that 
you do not expect to 
convert to cash within one 
year. A fixed asset is 
usually something you use 
to run your business (such 
as company vehicles, 
machinery, and 
computers).
13
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Setting up your company file using the EasyStep Interview

To set up your company file:

Start QuickBooks by double-clicking the QuickBooks icon on the desktop, or by 
choosing QuickBooks from the Programs group on the Windows Start menu.

Click “Create a new company”, or from the File menu choose New Company.

The Welcome screen for the EasyStep Interview is displayed. Follow the on-screen 
instructions and complete the interview.

Completing your company set up
This section describes some additional tasks you might need to do as you begin 
using QuickBooks. 

Note: Depending on how much information you entered during the EasyStep Interview, 
some of these tasks might not apply to you.

Determine your start date

Do this task if you did not enter a start date during the EasyStep Interview.

You need to set a start date before you begin using your company file in QuickBooks. 
QuickBooks uses a start date as the point at which you begin entering your business 
transactions. You must enter all transactions between your start date and today to 
ensure complete and accurate accounting records for your business.

Many business owners base their accounting records on their financial year so that 
they can see transactions for the entire year. If this is not important to you, you can 
choose a different starting point, such as today or the first of the month, quarter, or 
year.

To enter a start date, create a balance sheet account (described on page 35) and 
enter the opening balance as of a specific date.

Tip  Complete the sections in the General tab before completing the sections in the 
other tabs. QuickBooks won’t know enough about your company to ask the rest of the 
Interview questions unless you fill in your basic company information first. 
Furthermore, Intuit recommends that you do not skip the interview process. The more 
information you enter with the EasyStep Interview, the more accurate your company 
file will be when you begin to use QuickBooks for your business. If you need to leave 
the interview and come back later, you can choose EasyStep Interview from the File 
menu to return to the interview.

Tip  If you use Microsoft Outlook or Symantec ACT!, you can import your existing 
customer and supplier information into QuickBooks instead of entering it manually. 
Refer to the QuickBooks in-product Help for instructions on how to prepare your 
customer and supplier data file for importing into QuickBooks. When you are ready to 
import your customers, refer to the instructions on page 17.
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Enter your company information

Do this task if you did not enter this information in the EasyStep 
Interview.

To enter the contact and legal information for your company, choose 
Company Information from the Company menu. To learn more about 
each of the fields and where the information you enter will be used in 
QuickBooks, click the Help button.

Create (fine tune) your accounts

When you complete the EasyStep Interview or select a preset chart of 
accounts, QuickBooks creates a chart of accounts for you. Review the 
chart of accounts to be sure it accurately reflects the accounts you 
need to run your business. You can change account names and edit, 
delete, or add accounts as necessary.

To view your chart of accounts, from the Lists menu, choose Chart of 
Accounts.

Complete your customer, supplier, and items lists

In order to bill customers and pay your bills with QuickBooks, you must 
update your customer, supplier, and item lists so that it accurately reflects 
your business. Instructions for setting up your customers, suppliers and 
items are provided in Chapter 4.

You can choose to enter this information all at once, or you can enter it 
as you work, using the Quick Add feature, described on page 29.

Enter historical transactions

If your start date is before today's date, you'll need to enter past 
transactions from the start date to today. This ensures that your 
QuickBooks records will be completely up-to-date and reports will be 
accurate.

Enter historical transactions in chronological order. For example, 
QuickBooks won't know how to credit a customer payment unless 
you've previously recorded the invoice to that customer.

Note: Entering historical transactions is especially important if customers 
don’t pay you at the time they receive goods or services. If you don’t enter 
historical transactions early on, it’s hard to track and collect late customer 
payments.
Did You Know?

Some types of businesses 
prefer to organise their 
accounts by number. Adding 
numbers can help you identify 
the type of accounts, thereby 
speeding up your account 
selection on various forms. 
You might want to develop and 
follow a consistent account 
naming and numbering 
convention.
For example:
• 1000-1999 - Assets
• 2000-2999 - Liabilities 
• 3000-3999 - Equity
• 4000-4999 - Income
• 5000-5999 - Expenses
• 6000-6999 - Other income 

and expenses

Using shortcuts

You can use the standard 
Windows shortcuts in 
QuickBooks.
• CTRL + C: Copy
• CTRL + X: Cut
• CTRL + V: Paste
• CTRL + F: Find
15
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Intuit recommends that you enter your transactions in this order:

• Invoices or statements you've sent out since your start date
• Purchase orders you've issued since your start date that you haven't received in 

full
• Cash or cheques you've received since your start date
• Bills you've received since your start date
• Bills you've paid since your start date
• Deposits you've made to any of your accounts since your start date
• Any other cheques you've written (for things other than bills) since your start date

Note: If you don't have time to enter all your historical transactions right away, don't worry. 
You don't need to enter all your past transactions before you start using QuickBooks for new 
transactions. Enter new transactions as they occur, then catch up with historical 
transactions when you can. Remember, though, that your account balances will be incorrect 
(and your reports may be wrong) until you enter all the past transactions.

Complete your bank account information

After you've entered your historical transactions, your account registers will contain 
entries reflecting bills you've paid, cheques you've written, and deposits you've 
received. To make your account registers complete, you must also enter these 
transactions:

• Cheques or other charges that happened before your start date but didn't appear 
on statements before your start date (i.e., have not cleared the bank account)

• Other cheques you wrote after your start date that were not for bills or accounts 
payable (for example, credit card payments)

• Deposits you made after your start date that were not customer deposits
• Deposits you made before your start date, but which didn't appear on statements 

before your start date
• Bank charges and fees
• Interest paid on your account

Refer to the in-product Help for step-by-step instructions on how to enter these 
transactions to make your account registers accurate.
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Did You Know?

Your financial data within 
QuickBooks is the heart of 
your business. Use these tips 
to help protect it. Answer 
questions like these rather 
than staying up at night 
worrying about them.
• Do the right people have 

access to the right data?
• What if my current location 

had a fire or other 
disaster? Am I prepared for 
this?

• How fast could I set up our 
business in a new 
location?

• Who has the backup files?
And, most importantly, keep a 
copy of your backup file off 
site! This is a simple 
procedure that many 
companies overlook or get out 
of the habit of doing. But the 
reality of it is, if your company 
data were lost, you would be 
devastated if you didn’t have a 
back up to rely on.
Synchronising with Microsoft Outlook or Symantec ACT!

If you use ACT! 3.08, 4.02 or Interact ACT! 2000 or Microsoft Outlook 
97, 98, 2000, 2002, or 2003 you can synchronise your contact 
manager with QuickBooks and transfer all your customer and supplier 
information (including address and phone) to QuickBooks.

Note: Intuit recommends synchronising your customer and supplier 
information before you enter any customers or suppliers manually.

To synchronise your customer and/or supplier information:

From the Company menu, choose Synchronise Contacts.

Note: If you are synchronising for the first time, we recommend that you 
back up both the data in your contact manager and your QuickBooks 
company file before you synchronise.

Follow the onscreen instructions. You might be asked to resolve 
conflicts between your QuickBooks and contact manager data, 
assign uncategorised names to QuickBooks lists, or create 
alternative entries for duplicate names. If you need assistance with 
any of these tasks, click Help.

When the Confirm Changes screen appears, review the list of 
changes and click Accept to apply the changes.

Enter any optional adjustments

After you've created your company file, you might need to make a few 
adjustments as of your start date. You might need to:
• Enter any VAT liability you owe that was not part of the historical 

transactions that you entered
• Adjust the Uncategorised Income and Uncategorised Expense 

accounts (for accrual basis only)
• Adjust for current income and expenses if your start date is not at 

the beginning of the financial year
• Distribute earnings and equity before your start date

Refer to the in-product Help for step-by-step instructions on how to 
enter these optional adjustments.

If you are unsure whether you need to enter these optional 
adjustments, check with your accountant.
17
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Activating QuickBooks

The second time you open QuickBooks, you will be asked to activate your software. 
Activation is a process that validates you as a licenced user of QuickBooks. It also 
entitles you to online benefits and helps to prevent unauthorised copying of your 
software.

You have up to six uses before you have to activate QuickBooks. After your sixth use, 
the activation wizard chooses a method by which it wants you to activate (Internet or 
phone). 

• If activating by the Internet, simply follow the instructions in the wizard (ensure you 
are connected to the Internet before you begin activation). 

• If activating by phone, our support staff will help you activate. You can call our 
activation line at 0845 606 2161 (within the UK) or +44 870 609 0601 (outside 
the UK); Monday to Friday from 9 a.m. to 5:30 p.m.

Note: If you’re using several copies of QuickBooks, you must activate each copy separately.

To activate QuickBooks:

From the File menu, select Activate QuickBooks.

Click Next to start the activation process, and follow the on-screen instructions.

During activation, your licence information (licence key) is sent to Intuit. After we 
verify your licence key, QuickBooks is activated and available for your use. 

Note: Activation does not collect, transmit, or use any personally identifiable information.

Next Steps

After you’ve installed QuickBooks, set up your company file and activated your 
software as described in this chapter, you should:

• Learn how to use QuickBooks and get answers to your questions 
(see Chapter 3).

• Learn how to perform some essential QuickBooks tasks (see Chapter 4).
• Learn how to set up QuickBooks payroll (see Chapter 5).
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It is easy to find your way around QuickBooks with the new Resource Area. It acts as a 
central hub leading to support, training tools, product updates and information about 
related services. Wherever you want to go, the Resource Area will point you in the right 
direction.

The Resource Area, shown below, automatically displays in the QuickBooks desktop when 
you open QuickBooks. You can close it down when ever you like. To reopen it, click 
Resource Area in the Navigator List.

Figure 1. The QuickBooks Desktop
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Did You Know?

Customising the desktop

You can modify the way that 
the QuickBooks desktop 
behaves and looks to suit your 
working style. To modify the 
QuickBooks desktop, choose 
Customise Desktop from the 
View menu.

Too many windows open?

If your QuickBooks work area 
becomes too cluttered with 
windows that you have open, 
you can close them all at once 
instead of closing them one at 
a time. To close all your open 
windows, go to the Window 
menu, and select Close All.

When you close down 
QuickBooks, it’s good practise 
to close all windows that you 
have open on your QuickBooks 
desktop. This is because 
whenever you open your 
company file, QuickBooks will 
attempt to open all the 
windows that you had open the 
last time QuickBooks was 
closed. So, if you want to save 
some time when opening your 
company file, close down all 
your windows before shutting 
down your software. 

To open your company file with 
no windows open on the 
QuickBooks desktop, hold 
down the Alt key while your 
company file is opening. 
Using the Resource Area

New User Area 

As a new user, you may feel apprehensive about the 
prospect of unfamiliar software. Don’t be. The New User 
Area is an ideal place to begin as it shows you what to 
expect before using QuickBooks. It will guide you through 
the setup process; explain how everything works – and 
show you where to find extra help.

Updates

It’s worth visiting the Updates section regularly to check for 
any new product enhancements and updates including any 
legislation changes such as Payroll Tax Table updates.

Support

Whatever your support needs, we have plenty of options to 
help you with your new software. This section explains your 
support options whether it’s using the 30 days of free 
support, or signing up for our eXceed support plan.

Products

Make direct comparisons of the features and benefits 
before making your next QuickBooks product choice. You 
can call us to discuss this further.

Services

Because every business has different requirements, we’ve 
created a range of helpful QuickBooks services for you. 
Whether its help with payroll, providing a solution for BACS, 
enabling you to accept debit and credit cards, or supplying 
stationery for all your business requirements – check this 
section to learn more. 

Grow Your Business

Increasing demands on management time usually goes 
hand-in-hand with business expansion. Dealing with this 
effectively can often make the difference between success 
or failure. Clearly, the financial aspects associated with 
growth need careful attention – so efficient, reliable help 
quickly becomes a very valuable asset.

Feedback

We continuously develop QuickBooks by listening to your 
valuable feedback. We welcome your views, and offer 
opportunities to comment on our products and services.
21



22
Displaying one window at a time or multiple windows
QuickBooks is preset to show only one window at a time. By displaying one window at 
a time at its full size, QuickBooks gives you more room to work on the task at hand. 
If you want to see more than one window – for example, to compare related reports 
side by side or to tile all of the open windows – choose Multiple Windows from the 
View menu. You can resize and move the windows as needed.

Figure 2. Comparing windows side by side

Adding icons to the Icon Bar
For quick access to the areas of QuickBooks you use most, you can customise the 
Icon Bar by adding the features and reports that you use most frequently. Think of 
the Icon Bar as a shortcut to QuickBooks windows.

Note: Some QuickBooks windows cannot be added to the Icon bar.

Figure 3. Adding a feature to the Icon Bar

You can add, rearrange, and remove items from the Icon Bar to suit your needs. To 
modify the Icon Bar from its current setting, choose Customise Icon Bar from the 
View menu.

When you display 
multiple windows, 
you can see all the 
windows that you 
have open. 

This is useful when 
performing a task 
that spans over 
many windows.

To add a shortcut to a 
QuickBooks window, open 
the window, then go to the 
View menu and choose the 
“Add to Icon Bar” option.
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Did You Know?

Moving your help window

You can move your Follow-Me 
Help window anywhere you like 
by clicking in the grey area at 
the top of the “Find” or 
“Follow-Me Help” window and 
dragging it to the position you 
want. When you drag a help 
window back to its original 
position in the sidebar area, it 
will automatically “snap” back 
in to position. 

Stopping Follow-Me Help

You can stop Follow-Me Help 
from tracking your activities. 
Say, for example, you are 
reading a lengthy help topic 
that requires you to open 
several windows for a given 
task, but you would rather the 
help window remain on the 
main help topic instead of 
displaying help topics for every 
subsequent window you open. 
To stop the help window from 
following what you are doing, 
click the Pin button at the top 
of the help window. 

Closing the Follow-Me 

Help

You can customise 
QuickBooks to open certain 
windows when your company 
file is opened. Say, for 
example, you want to keep the 
Follow-Me Help windows 
closed. To do this, first you 
must close Follow-Me Help 
(from the View menu, select 
Follow-Me Help; if there is no 
tick mark beside the Follow-Me 
Help menu, then your help is 
already closed). Then go to the 
View menu and select 
Customise Desktop. Select 
the “Save current desktop” 
option. The next time you open 
QuickBooks, the Follow-Me 
Help windows will not appear.
Getting Answers to Your Questions

QuickBooks provides a variety of tools and resources to help you find 
answers to questions you might have when using QuickBooks. 

Using the in-product Help system
QuickBooks in-product Help is an extensive system that provides 
background information and step-by-step instructions for doing every 
QuickBooks task. The Help system contains 

• Follow-Me Help
• Tools for helping you find information
• How Do I menus

Using Follow-Me Help

QuickBooks Follow-Me Help is a “smart” HTML-based help system. The 
Follow-Me Help window follows you as you work in QuickBooks and 
displays topics that are related to what you are doing. For example, if 
you have an invoice open, the Follow-Me Help automatically displays 
information on creating invoices. You no longer have to seek the 
information yourself.

The Follow-Me Help window is open and displayed on the bottom left 
side of the QuickBooks work area. If you close this window, you can 
open it again by going to the Help menu and selecting Follow-Me Help. 
You can also open the Follow-Me Help from the View menu. 

Figure 4. The QuickBooks Follow-me Help window

Note: Some help topics are too large to be displayed in the Follow-Me Help 
window. Larger topics are opened in a separate full-sized help window. 

The  symbol means 
that there is information 
hidden. Click this symbol 
to display the information.

This is a list of topics 
related to the currently 
displayed help topic. 
Clicking links with a  
symbol displays text 
beneath the link. Clicking 
links that have no symbol 
takes you to a completely 
different help topic.

Use the Back and Next 
buttons to move through 
the topics you’ve visited.

Use the Index and Search buttons to 
help find topics for a specific term or 
concept. The Index and Search tools 
are opened in the Find window.

Use the Pin button to stop 
the Follow-Me Help from 
following your activities.
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Using the Index and Search tools to find information (Find window)

QuickBooks in-product Help is quite extensive. Sometimes the easiest way to find the 
Help information you need is to use the Search or Index.

To find information using the Index:

From the Help menu, choose Index, or go to the Follow-Me Help window and click 
the  (Index) symbol. The Index is displayed in the Find window. 
Enter a term in the blank field. The index will scroll to display the available 
entries.

Click the index entry that best describes the help topic that you want to see. The 
help topic is displayed in the Follow-Me Help window. 

To find information using Search:

• Type your question in the Ask field in the title bar of most QuickBooks windows and 
click Ask.

or

• From the Follow-Me Help window, click the  (Search) symbol. The Search tool is 
opened in the Find window. Type your question in the Ask field, and click Ask.

Getting step-by-step instructions

Throughout QuickBooks you’ll find windows that have a “How Do I” button at the top. 
Clicking this button provides quick access to instructions for tasks that are 
associated with the window.

Type your question here to search 
the in-product help system.
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Did You Know?

Using Search Effectively

Entering questions of 
3-10 words produce better 
search results than simple 
keywords. For example, 
instead of typing “invoices”, 
type “How do I create 
invoices?” in the search field.

Questions should be as 
specific as possible. They 
should not get too long or 
contain too many keywords. 
For example, “How do I add 
customers?” will return better 
results than “How do I add 
new customers and 
suppliers?”

If you get no search results, 
check the spelling in your 
question. QuickBooks knows 
about some common 
misspellings, but other 
misspellings will not be 
caught. Do not use 
abbreviations. Try different 
keywords.

Sample company files

QuickBooks includes some 
sample company files that you 
can practise with to enter 
pretend data, run reports, and 
explore QuickBooks features.

To open a sample company 
file, choose Open Company 
from the File menu and then 
choose a sample company file 
from the list.
Additional self-help tools
If you cannot find the answer you want in the in-product Help, try these 
other self-help tools.

Using the Frequently Asked Questions Knowledge Base

The QuickBooks Frequently Asked Questions (FAQs) knowledge base 
on our Support site provides a free library of hints and tips to help you.

To find information on the QuickBooks FAQ knowledge base:

In the Follow-Me Help, go to the Find window. If the Find window 
isn’t visible, go to the View menu and select Follow-Me Help.
Click the Look Online button at the top of the Find window. 

Enter a term in the blank field and click Search. The Help system 
opens a browser window and begins searching the FAQ knowledge 
base on our support site. (eXceed members have access to extra 
articles.)

Articles that match the term you entered are displayed. Click the 
article that best describes the information you want to see. 

QuickBooks eXceed Support Knowledge Base

With a subscription to the eXceed support package, you have instant 
access to a variety of extra online help tools. Check it out during your 
30 days free support period at www.quickbooks.co.uk/exceed

QuickBooks Tutor

If you want to jump right in and start learning QuickBooks without using 
your live data, then the QuickBooks Tutor is for you. The tutor is an 
interactive tutorial that allows you to perform some common tasks 
such as setting up a customer and getting paid in QuickBooks using 
sample data.

To open the QuickBooks Tutor:

Go to the Help menu and choose QuickBooks Tutor.

Select Start QuickBooks Tutor if you want to complete the entire 
tutorial in sequence or select each lessons separately.

Click Look Online to search our 
FAQ knowledge base online.

Click Search to search 
for information in the in-
product Help system.

You must be 
connected to the 
Internet to look 
at the FAQ 
knowledge base.
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Getting assisted support
The most valuable help comes on your own terms. What will work 
best for you in any given situation? There are a number of options – 
and we show you how to find them. Call us if you have any queries 
or want to subscribe to any service. 

Intuit contact information

You can speak to our Customer Services team by ringing 

• Within the UK: 0845 606 2161 
(Monday - Friday, 9 a.m. - 5:30 p.m. excluding UK Bank holidays)

• Outside the UK: +44 870 609 0601

Free 30 days support

It’s reassuring to have the back up of fast, expert help especially in the early days. As 
a new or upgrading customer, we offer you free unlimited telephone support and 
online assistance for 30 days. This service is available as soon as you have 
activated your software.

QuickBooks eXceed support plan

QuickBooks eXceed Support is a dynamic combination of unlimited telephone and 
online support, available as a subscription service after your 30 days of free support 
has ended. 

To learn more about our eXceed Support, ring us at 

• Within the UK: 0845 606 2161 
(Monday - Friday, 9 a.m. - 5:30 p.m. excluding UK Bank holidays)

• Outside the UK: +44 870 609 0601

Finding local QuickBooks help

From time to time, you might need advice that is very specific to your 
business situation. In this case, you’ll want to contact your accountant or 
another specialised professional.

If you do not have an accountant or bookkeeper working for you, you can find a 
QuickBooks Professional Advisor located near you from our Web site. QuickBooks 
Professional Advisors are independent accountants, bookkeepers, computer 
consultants, and trainers who work with small businesses every day. They can offer 
guidance on everything from business planning to tax advice.

To find a Professional Advisor in your area, open a Web browser and enter the URL: 
http://www.quickbooks.co.uk/

Then, click the button “Search for a Professional Advisor”.
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Re-sorting your lists

By default, when you add 
entries to a list in QuickBooks, 
QuickBooks keeps entries of 
the same type together. If you 
prefer to have the entries in 
your lists ordered alphabetically, 
you can re-sort them. 

The following lists can be 
re-sorted alphabetically. 
• Chart of Accounts
• Class
• Customer:Job
• Customer Type
• Item
• Job Type
• Memorised Transactions
• Supplier Type

To re-sort list entries 
alphabetically, open the list 
you want to alphabetise and 
click the Name column at the 
top of the window. 

QuickBooks re-sorts the 
entries alphabetically. 

To return the entries back to 
their original order, select 
Re-sort List from the menu 
button at the bottom of the list 
window.
QuickBooks Basics

To take full advantage of QuickBooks, there are some important 
concepts you need to understand.

How QuickBooks lists work
Lists are one of the important building blocks that make QuickBooks 
so powerful and efficient. You use information stored in lists to fill out 
most QuickBooks forms. For example, to create an invoice, you choose 
the customer name from your Customer:Job list. QuickBooks 
automatically enters the customer information on the form for you. This 
saves you time and prevents typing errors. You can also change the 
information directly on the form as needed.

Lists are easy to set up in QuickBooks, but do require careful planning. 
Each list you create has its own List window. Important QuickBooks 
lists include:

• Chart of Accounts
• Items (stock and services)
• Customers
• Suppliers
• Employees

To view a QuickBooks list, choose the list you want from the Lists 
menu.

To enter information in these lists, use the menu button at the bottom 
of the list to add, edit, or delete list items. The list menu also provides 
access to common features associated with the list.

The more detail you enter for each list item, the more information 
QuickBooks can use to pre-populate forms, track financial data, and 
display useful reports about your business. Another advantage of lists 
is that common tasks like adding list entries, editing list information, 
and deleting list entries are performed the same way.

Figure 5 on page 28 illustrates how QuickBooks uses list information 
across multiple windows and tasks to simplify data entry and give you 
a complete picture of how your business is doing.
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What happens when I 

record a bill payment?

If you paid by:

Cheque. QuickBooks prepares 
one cheque for each supplier 
and records the cheques in the 
cheque register with BILLPMT 
in the Type field. 

Credit card. QuickBooks 
records a charge for each 
supplier in your credit card 
register. 

Cash. QuickBooks records a 
payment for each supplier in 
your cash account register. 

In each scenario, QuickBooks 
records the payment to each 
supplier in the accounts 
payable register. The amount 
you paid appears in the 
Payment column.

Key Term

Accounts Payable

The accounts payable register 
lists in date order all the bills, 
payments, and credits related 
to your suppliers. You can 
enter new bills and payments 
directly into the register and 
quickly open any transaction 
listed.
Entering list information as you work

There are two basic methods you can use to enter list information in 
QuickBooks. You can enter account, customer, supplier, product and 
service information before you enter transactions in QuickBooks, or 
you can enter this information “on the fly” as you use the product.

If you prefer to enter information as you use QuickBooks to perform 
your daily tasks, QuickBooks will prompt you to immediately set up any 
entry it does not know about. For example, if you try to create an 
invoice for a customer named Tracey Stewart and you have not entered 
information about Tracey Stewart into QuickBooks, QuickBooks will 
prompt you:

Clicking QuickAdd creates a new customer list entry for Tracey Stewart 
in the Customer:Job list and adds all the information you enter about 
the customer on the invoice form (billing address, payment terms, etc.) 
to her customer record.

Clicking Set Up takes you to another window where you can enter 
information not covered by the invoice. For example, you could click Set 
Up to enter Tracey Stewart’s phone number, fax number, and credit 
limit. 

Note: If you choose Quick Add, you can always add more information to the 
customer's record at a later time.

Writing cheques versus paying bills
In QuickBooks, you can manage and pay your bills in two ways: 

Pay bills as soon as you receive them.  Use the Write Cheques 
window and assign the amounts to appropriate expense accounts. 

Wait to pay bills until they are due.  Enter bills into your accounts 
payable account and set up QuickBooks to remind you to pay bills 
when they are due. Using this method, you keep your money in your 
business for as long as possible. You might still use a cheque to pay 
the bill, but this method enables you to track how much money you 
owe. And at any time, you can run reports to analyse unpaid bills for 
information such as which suppliers you owe money to. 

Figure 6 illustrates the difference between writing cheques as soon as 
you get a bill and using the accounts payable register to track and pay 
bills.
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Figure 6. Two methods of receiving and paying a bill from a supplier

Note: Do not simply write a cheque in the Write Cheques window to pay bills that you 
entered in the accounts payable register or the Enter Bills window. Use the Pay Bills window 
to pay these bills. When you use the Pay Bills window, QuickBooks will write the cheque for 
you automatically. Furthermore, if you do not use the Pay Bills window, you will have 
outstanding debts listed in your accounts payable register, so reports that you run will list 
items that you’ve already paid, and you might mistakenly pay the same bill twice.
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Setting Up Your Business

Did You Know?

Company preferences

Company preferences are 
global preferences that affect 
all users of the company file. 
Only the QuickBooks 
Administrator can set up or 
modify company preferences. 

Learn More

To learn more on customising 
QuickBooks, go to the Find 
window and type in the 
following terms to search for 
these help topics:

Setting preferences
Turning features on and off
Customise QuickBooks 

desktop

What if the Find window 

is not visible? 

The Find window is part of the 
in-product Help system. If you 
closed the Find window, you 
can open it again by going to 
the View menu and selecting 
Follow-Me Help. The Find 
window opens, by default, on 
the left hand side of the 
QuickBooks work area.
Customising QuickBooks for the Way You Like 
to work

QuickBooks uses preferences to customise QuickBooks to suit the 
needs of your business and your personal style of working. From the 
QuickBooks Preferences window, you can define preferences in over a 
dozen different areas.

For example, you can configure general preferences such as whether or 
not QuickBooks prompts you before editing or deleting a transaction, or 
which date QuickBooks uses for new transactions. Or, you can 
configure accounting-specific preferences such as how QuickBooks 
displays accounts and subaccounts or whether to use features such as 
sales orders, VAT, or multicurrency.

To view and set preference options:

From the Edit menu, choose Preferences. 

In the Preferences window, change any of the general QuickBooks 
preferences. These preferences determine how QuickBooks 
behaves.

Use the scroll box on the left to display the preferences for another 
area of QuickBooks. For example, to set preferences for jobs and 
estimates, select Jobs & Estimates. 

On the My Preferences tab for the particular feature area, select the 
changes and settings that you want. These settings affect only your 
QuickBooks sessions, not those of other users.

Do one of the following: 
• Click OK to save your changes and close the Preferences window. 
• Click another feature area in the scroll box to enter other 

preferences.

Click OK.
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Setting Up Your Business

Key Terms

Accounts

There are two types of 
accounts: balance sheet 
accounts (such as current and 
savings), and accounts used 
to group transactions for 
reporting purposes (such as 
income and expense 
accounts). Refer to pages 36 
and 37 for a description of the 
different QuickBooks 
accounts.

Chart of Accounts

A complete list of your 
business' accounts and their 
balances. You use a chart of 
accounts to track how much 
money your company has, how 
much money it owes, how 
much money is coming in, and 
how much is going out.

Learn More

Add phone numbers for 

easy follow-up

You can add phone numbers to 
your Accounts Receivable 
reports by clicking the Modify 
Report button located at the 
top of the report. Tick the 
Name Phone # column. The 
customers’ phone numbers 
will be displayed on the report. 
This will be handy when you 
want to follow up on the 
overdue invoices.
Adding an Account

When you set up your company file, QuickBooks sets up certain 
accounts for you automatically. However, as your business grows or 
changes, you might need to add new accounts to your chart of 
accounts to better organise your finances. Or, you might need an 
account that was not provided during setup. For example, you might 
want to create expense accounts to track office supply purchases 
separately from advertising costs.

To add an account:

From the Lists menu, choose Chart of Accounts.

From the Account menu button, click New.

In the New Account window, choose the type of account from the 
Type drop-down list.

Note: Refer to pages 36 and 37 for a description of the different types of 
income, expense, and balance sheet accounts.

Enter the account’s name in the Name field. This name will appear 
on all your company financial statements.

If you want to make this account a subaccount of another account, 
tick the “Subaccount of” check box. From the drop-down list, select 
the account that will be the higher-level account for this 
subaccount.

(Optional), enter a short description, note, bank account number, or 
credit card number, depending on the type of account you are 
adding.

For balance sheet accounts. Enter an opening balance based on the 
account’s balance as of your QuickBooks start date. If you’re not 
sure of the balance, you can leave the field blank and enter the 
information later.

Click OK.

Why use subaccounts?
When you need more detail about what’s going on in an account, you 
can divide the account into one or more subaccounts. Subaccounts let 
you track several related types of income or expenses independently 
yet keep them all under the “umbrella” of a single parent account. 
Subaccounts appear indented immediately below their parent account 
in your Chart of Accounts.

For example, if your business has substantial advertising expenses, 
you might decide to divide your Advertising expense account into 
several subaccounts, such as Newspaper Ads, Signs, Yellow Pages 
Listing, and Direct Mailings.
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For a brand new account
When you create a brand new account, leave the opening balance at zero. Its opening 
balance will be created automatically when you transfer funds from another account.

What type of account should I use?
There are two main types of accounts in the QuickBooks chart of accounts:

• Balance sheet accounts
• Income and expense accounts

Balance sheet accounts

QuickBooks provides ten types of balance sheet accounts to choose from as you 
create and add to your chart of accounts. Use the type of account that best 
describes the type of data you are tracking.

Use this account To track

Bank
Current, savings, and money market accounts. Add one bank 
account for every account your company has at a bank or other 
financial institution. (You can also use this type for petty cash.)

Accounts receivable 
(A/R)

Transactions related to the customers that owe you money, 
including invoices, payments, deposits of payments, refunds, 
credit memos, and statements. 

Other current asset
Assets that are likely to be converted to cash or used up within 
one year, such as notes receivable due within a year, prepaid 
expenses, and security deposits.

Fixed asset
Depreciable assets your company owns that aren't likely to be 
converted into cash within a year, such as computers, motor 
vehicles, or furniture.

Other asset
Any asset that is neither a current asset nor a fixed asset, such 
as long-term notes receivable.

Accounts payable 
(A/P)

Transactions related to money you owe, including bills, bill 
payments, and any credit you have with suppliers. See also 
current and long-term liability accounts.

Credit card Credit card purchases, bills, and payments.

Other Current liability
Liabilities that are scheduled to be paid within one year, such as 
VAT, payroll taxes, accrued or deferred salaries, and short-term 
loans.

Long-term liability
Liabilities such as loans or mortgages scheduled to be paid over 
periods longer than one year.

Equity
Owner's equity, including capital investment, owner’s drawings, 
and retained earnings (accumulated profit and loss).
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Did You Know?

Adding additional 

accounts

You can also add accounts as 
you perform your everyday 
tasks. For example, if you are 
writing a cheque and enter an 
account name that has not yet 
been set up in QuickBooks, 
QuickBooks will prompt you to 
set up the new account.
If you need to change your 
account information, select the 
account in the Chart of 
Accounts list and from the 
Accounts menu button, click 
Edit.

Undeposited Funds 

account

The Undeposited Funds 
account is automatically 
added to your Chart of 
Accounts the first time you 
receive a payment from an 
invoice or sales receipt. This 
account is used to hold the 
money until you deposit it into 
a bank account. For more 
information on Undeposited 
Funds, search for “how does 
undeposited funds work” in 
the Find window.

Learn More

To learn more on managing 
your accounts, go to the Find 
window and type in the 
following terms to search for 
these help topics:

Adding accounts
Adding subaccounts
Changing accounts
Editing a transaction
How to use registers
Reconciling with your 

financial statement
Voiding or deleting a 

transaction
Understanding the chart of 

accounts
Income and expense accounts

Income and expense accounts track the sources of your income and 
the purpose of each expense. When you record transactions in one of 
your balance sheet accounts, you usually assign the amount of the 
transaction to one or more income or expense accounts. For example, 
not only do you record that you took money out of your current account, 
but you keep track of what you spent the money on (utilities or office 
supplies).

Note: QuickBooks does not display balances for income and expense 
accounts in the chart of accounts. To see these balances, select the income 
or expense account in the chart of accounts and from the Reports menu 
button, click QuickReport.

Use this account To track

Income
The main source of money coming into your 
company.

Other income
Money received for something other than normal 
business operations, such as interest income.

Expense Money that is leaving your company.

Other expense
Money spent on something other than normal 
business operations, such as corporate taxes.

Cost of Goods Sold The cost of items that you sell.
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Setting Up Your Business

Key Term

Customers

Customers are the people or 
businesses to whom you sell 
your products or services, that 
is, the people who pay you for 
what you do. Some 
businesses might refer to a 
customer as a client or 
member.

Did You Know?

Adding jobs

If you are performing more 
than one job for a customer, 
you can track the jobs 
individually by adding new jobs 
under the Customer's name in 
the Customer:Job list. That 
way, you can create reports 
that show the income and 
expenses for each job.

Learn More

To learn more on managing 
your customers, go to the Find 
window and type in the 
following terms to search for 
these help topics:

About contact management 
synchronisation

Adding customers
Editing a list entry 
Editing a transaction
Removing entries from lists
Setting up multiple jobs
Setting up payment terms
Setting up VAT for 

customers

Voiding or deleting a 
transaction

What if a customer is also 
a supplier?
Adding Customers

Customers are the lifeline of your business. By entering detailed 
information in QuickBooks about the people and companies to whom 
you sell your products and services, you can personalise their bills, 
send invoices easily, and quickly view the status of their accounts. You 
can add new customers at any time.

To add a customer:

From the Lists menu, choose Customer:Job List.

From the Customer:Job menu button, click New.

In the Address Info tab, enter all the data that you have about the 
customer, including his or her name, billing and shipping 
addresses, and additional contact information.

Complete the Additional Info and Payment Info tabs, as appropriate.

If you want to add additional fields to the form, click Define Fields to 
customise the form.

Click OK or Next (if you want to enter another customer).

Emailing your customers saves you time and money

You can easily email your invoices and sales receipts to your 
customers. Simply add their email address to the Address Info tab 
Then when you have an invoice to email, click the Email button located 
on the top of the form. QuickBooks creates an email and attaches a 
pdf copy of the invoice.

Tip  Typing in customer data for hundreds of customers can be a 
tedious task. If you use Microsoft Outlook or Symantec ACT!, you can 
synchronise your customer data with QuickBooks instead of entering it 
manually. For instructions on importing your customer data, go to the 
Find window and search for the following help topic: “about contact 
management synchronisation”. When you are ready to import your 
customers, refer to the instructions on 17.

Tip  You can also add customers as you perform your everyday tasks. 
For example, if you enter the name of a new customer when filling out 
an invoice, QuickBooks will prompt you to enter information about this 
customer. You can choose from two quick setup options:

• QuickAdd—Adds just the name to the list without disrupting 
what you are doing. You must add the customer’s details later.

• Set Up—Opens the New Customer window so you can set up all 
of the customer’s details in the Customer:Job List.
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Setting Up Your Business

Key Term

Suppliers

Suppliers are any businesses 
or people from whom you buy 
or rent goods or services for 
your business – office 
supplies, phone or computer 
services, or products that you 
sell. The tax agencies that you 
pay are also your suppliers. 
Nearly everyone you pay other 
than employees are suppliers.

Did you Know?

If you are transferring data 
from another accounting 
software or if your current 
supplier lists are in a 
spreadsheet format, you can 
import your supplier list into 
QuickBooks using Excel. 
Call us during your 30 day free 
support and we will tell you 
how to do it. 

Learn More

To learn more on managing 
your suppliers, go to the Find 
window and type in the 
following terms to search for 
these help topics:

Adding suppliers
Editing a list entry 
Removing entries from lists
Paying suppliers
Setting up payment terms
What if a supplier is also a 

customer?
Synchronising with ACT! or 

Outlook
Adding Suppliers

QuickBooks uses the Suppliers List to hold information about the 
people and companies you buy goods and services from to run your 
business; for example, this list could include the phone company, your 
office supplies supplier, and utility company. You can add new suppliers 
at any time.

To add a supplier:

From the Lists menu, choose Suppliers List.

From the Supplier menu button, click New.

In the Address Info tab, enter all the data that you have about the 
supplier, including his or her name, address, and additional contact 
information.

If you owe this supplier money as of your company’s start date, 
enter the amount in the Opening Balance field. 

Click the Additional Info tab and complete the form, as appropriate.

If you want to add additional fields to the form, click Define Fields to 
customise the form.

Click OK or Next (if you want to enter another supplier).

Tip  Typing in supplier data for hundreds of suppliers can be a tedious 
task. If you use Microsoft Outlook or Symantec ACT!, you can import 
your existing supplier information into QuickBooks instead of entering 
it manually. For instructions on importing your supplier data, go to the 
Find window and search for the following help topic: “about contact 
management synchronisation”. When you are ready to import your 
suppliers, refer to the instructions on 17.

Tip  You can also add suppliers as you perform your everyday tasks. 
For example, if you enter the name of a new supplier when paying a 
bill, QuickBooks will prompt you to enter information about this 
supplier. You can choose from two quick setup options:

• QuickAdd – Adds just the name to the list without disrupting 
what you are doing. You must add the supplier’s details later.

• Set Up – Opens the New Supplier window so you can set up all of 
the supplier’s details in the Supplier List.
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Setting Up Your Business

Key Term

Items

An item is anything that might 
appear as a line item on an 
invoice or a purchase order, 
including subtotals, and 
discounts as well as the 
products and/or services that 
you sell. You enter items on 
your invoices and sales 
receipts. For example, a writing 
consultant might set up one 
item for editing services with 
an hourly rate, and another 
item for writing services with a 
different hourly rate. On an 
invoice, the items would be 
entered with the number of 
hours worked as the quantity.

While providing a quick means 
of data entry, items also 
handle the behind-the-scenes 
accounting. When you create 
an item, you link it to an 
account; when the item is 
used on a form, it posts an 
entry to that account and 
another to the accounts 
receivable, accounts payable, 
current, or other account.

Did You Know?

You can hide an item on the 
item list without deleting it by 
making it inactive. When an 
item is inactive, the 
information associated with 
the item is kept, but 
QuickBooks hides the item 
from the list and you can no 
longer select it from certain 
forms. To make an item 
inactive, select it from the Item 
List, click the Item menu 
button and select Make 
Inactive. To see inactive items 
in the list. click the Show All 
button.
Adding Items

In QuickBooks, an item is anything that your company buys, sells, or 
resells to run your business. Items are your products, services, and 
things such as shipping and handling charges, subtotals and 
discounts.

On a sales form, when you choose an item from the Item list, 
QuickBooks fills in a description of the line item and calculates its 
amount for you.

QuickBooks provides many different types of items, described in the 
table on page 44. Some items, such as service or stock part items, 
help you record the services and products your business sells. Other 
items, such as the subtotal or discount item, are used to perform 
calculations on the amounts in a sale.

To add an item:

From the Lists menu, choose Item List.

From the Item menu button, click New.

From the Type drop-down list, choose the type of item you want to 
create. (See table on page 44 for an explanation of item types.)

Enter an item name as you want it to appear on purchase and sales 
forms.

Enter the description that you want to appear on sales forms when 
you use the payment item.

In the Rate field, enter the amount you want to charge for the item.

In the Account field, choose the account that is associated with this 
item. 

In the Sales VAT Code list, select the VAT code that represents the 
taxes you need to charge on this item. If you do not see the Sales 
VAT Code list, you must turn the sales VAT preference on. Refer to 
“Setting up your VAT” on page 47 for more information on VAT.

Click OK or Next (if you want to enter another item).

Do you stock and sell items in different units? 

Refer to “Setting up items in different units of measure” on page 45 
for more information on setting up the items that you buy and sell in 
different units of measure.
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Which item type should I choose?
QuickBooks provides the following different types of items to help you fill out sales 
and purchase forms quickly.

Item Type Purpose

Services
Use for services you either charge for or purchase, 
like specialised labour, consulting hours, and 
professional fees.

Stock part
Use for goods you purchase, track as inventory, and 
resell.

Stock Assembly Use for goods that you assemble from parts you buy.

Non-stock part
Use for goods you buy but don't track, like office 
supplies, or materials you buy for a specific job that 
you charge back to your customer.

Fixed asset 

Use for an asset you do not expect to convert to cash 
during one year of normal operations. A fixed asset is 
usually something that is necessary for the operation 
of your business – like a motor vehicle or computer.

Other charge
Use for miscellaneous labour, material, or part 
charges, such as delivery charges, setup fees, and 
service charges.

Subtotal
Use to total all items above it on a form, up to the 
previous subtotal. Useful for applying a percentage 
discount or surcharge to many items.

Group
Use to quickly enter a group of individual items on an 
invoice.

Discount

Use to subtract a percentage or fixed amount from a 
total or subtotal. Do not use this item type for an early 
payment discount; for an early payment discount, use 
the Receive Payments window.

Payment
Use to record a partial payment you received at the 
time of the sale. It reduces the amount owed on an 
invoice.
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Learn More

To learn more on working with 
items, go to the Find window 
and type in the following terms 
to search for these help topics:

Types of items
Creating items for services
Creating items for non-

stock parts
Creating items for stock
Creating subitems
Changing the sales price of 

items
Changing an item’s type
Making an item inactive
Reports about items
units of measure

Did you Know?

When you define different 
stocking units for an item, 
QuickBooks displays the 
appropriate stocking unit on 
your forms. For example, sales 
forms show an item’s selling 
unit and purchasing forms 
show an item’s purchasing 
unit. You cannot show an 
item’s purchasing unit on a 
sales form and vice versa. 
Also, some reports break 
down items by their units of 
measure. The unit that is 
shown depends on the report 
that is being created. For 
example, reports that show 
the total number of items 
you’ve purchased will display 
items in their purchasing unit 
(if one was defined). Reports 
on sales will display items in 
their sales unit. 
You can change reports to 
display in any unit you want by 
clicking the Modify Report 
button at the top of the report.
Setting up items in different units of measure
In QuickBooks, you can keep the items in your stock in one unit of 
measure and sell them in another. For example, buying lemonade in a 
case that holds 12 cans, then selling the cans individually.

To turn on units of measure:

From the Edit menu, choose Preferences.

From the scroll box on the left, select Purchases & Suppliers.

On the Company Preferences tab, select “Stock and purchase 
orders are active” if it isn’t already.

Select “Units of Measure are active”.

To set up items in different units:

You can only set up different units of measure for the following types of 
items: Stock Part, and Stock Assembly.

From the Lists menu, choose Item List.

From the Item menu button, choose New. The New Item window 
opens.

From the Type field, select Stock Part or Stock Assembly. 

Click the Units of Measure button.

In the Stocking Unit section, enter the name of the unit that you use 
to stock this item (eg., you stock your lemonade in a case, so enter 
case).

If you sell this item in a different 
unit than how it is stocked: In the 
Sales Unit section, clear the 
Same as Stocking check box, 
then define the sales unit and 
enter the number of individual 
sales units that are packaged in 
the stocking unit.

If you purchase this item in a 
different unit than how it is stocked:
In the Purchasing Unit section, clear the Same as Stock check box, 
then define the purchasing unit and enter the number of stocking 
units that are packaged in the purchasing unit.

Click OK, and continue setting up the item.

Caution  Once you have turned on the units of measure 
preference, you cannot turn it off again. You should only consider 
activating units of measure if you buy, stock and sell in different 
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Key Term

Sales VAT Codes 

When you turn on VAT, 
QuickBooks sets up a list of 
default VAT codes. These VAT 
codes live in the VAT Codes 
List. You assign these codes 
to the items that you sell and 
buy. QuickBooks uses these 
VAT codes to correctly 
calculate and record your VAT 
for you.

Did you know?

Registering for VAT

Your business does not have 
to be VAT registered if your 
annual turnover is less than 
£60,000.

VAT liabilities 

If you started collecting VAT 
before you began using 
QuickBooks, you need to 
enter the amount of VAT 
that you still owe to the 
HMRC as of your 
QuickBooks start date, 
otherwise you may be filing 
an incorrect VAT return. For 
more information on 
updating your VAT liability in 
QuickBooks, search for 
“entering VAT liability” in 
the Find window.

Customers with special tax 

status

You can assign VAT codes to 
customers that have a special 
tax status. For more 
information on this, search for 
“assigning VAT codes to 
customers” in the Find 
window. 
Setting up your VAT
QuickBooks supports the two most common VAT schemes: Standard 
VAT Accounting and Cash VAT Accounting.

• Standard VAT Accounting scheme: where you pay VAT on sales and 
purchases when you send an invoice or receive a credit note, and 
very likely before you have received any money for these transactions 
from your customers.

• VAT Cash Accounting scheme: where you pay and reclaim VAT only on 
the basis of cash received in and cash paid out by you. This scheme 
is meant to help smaller businesses with their cash flow. To qualify, 
your annual turnover must be below £660,000 (limit as of January 
2006).

To turn on the VAT feature: 

From the Edit menu, choose Preferences.

In the Preferences window, select VAT from the scroll box on the 
left.

Click the Company Preferences tab, and for the question “Do you 
track VAT”, select Yes. 

Set up your VAT preferences. Here, you can enter your VAT 
registration number, select your tax reporting period and the VAT 
scheme for which you are registered.

Tip  Intuit recommends that you set up VAT in QuickBooks by 
completing the EasyStep Interview. If you skip the EasyStep Interview 
when setting up your company file, you will have to turn on the VAT 
preference yourself and assign VAT codes to the items you sell and 
buy. The VAT codes are automatically created when you set up your 
company file. To set your VAT preferences, refer to the instructions 
below (only if you skipped the EasyStep Interview). 
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Assigning VAT codes to the items you sell and buy

QuickBooks uses VAT codes to keep track of how much VAT you have collected from 
your customers (output tax), and how much you’ve paid out on the items you’ve 
purchased for your business (input tax). 

For QuickBooks to calculate the correct amount of VAT on the items you buy and sell, 
you need to associate a VAT code to each item. Once you do so, QuickBooks can 
automatically charge the correct amount of VAT on your sales and purchasing forms, 
and then calculate your refund or amount owed to the HM Revenue & Customs when 
you next complete your VAT return.

To assign VAT codes to your items: 

From the Lists menu, choose Item List.

Choose New from the Item menu button. 

If you purchase the item: 

In the Purchase Information section, go to the Purch VAT Code field and select the 
correct VAT code for this item. If you don’t see the Purchase Information section, 
tick one of these check boxes (I purchase... This item is purchased... or This 
service is performed by a...).

If you sell the item:

In the Sales VAT Code field, select the VAT code that you charge your customers 
for this item. 

Remitting Your VAT Returns

When you are registered for VAT, you have to send a VAT return to the HM Revenue & 
Customs at the end of each tax period. Whether you send a return using paper forms 
or do it electronically, filing your VAT is easy with QuickBooks.

The steps you follow to file your VAT return in QuickBooks is different depending on 
the VAT scheme you use. 

Tip  You can see what your VAT liability is at any time by creating a VAT 100 report. To 
create this report, go to the Reports menu, select VAT, and choose VAT 100. Set the 
date to the tax period you are filing and then regenerate the report if necessary.
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Did You Know?

What if I am expecting a 

refund from HMRC?

If you are receiving a VAT 
refund, QuickBooks 
automatically creates an 
invoice for the HM Revenue & 
Customs. When you get the 
cheque from the HM Revenue 
& Customs, receive it against 
the invoice as you would with 
any other payment from a 
customer.

Learn More

For complete instructions on 
setting up your VAT and filing a 
VAT return, read the Tracking 
and Paying VAT chapter of the 
User Guide. You can open the 
User Guide, by going to the 
Help menu, selecting 
QuickBooks Guides, then User 
Guide. 
You can also search for these 
help topics:

Adjusting VAT
An overview of VAT codes
Collecting and paying VAT
Filing your VAT
Entering VAT liability
Recording VAT refund
VAT reports
Completing a Standard VAT scheme return

When you complete a VAT Return for any tax period, QuickBooks marks 
every transaction on that return as ‘filed’, which prevents transactions 
from being included in future returns. You can easily see this in the VAT 
Control account. 

On the other hand, because QuickBooks sets a ‘filed’ flag on each 
transaction, it means that you can enter transactions in an earlier 
period without having to worry about adding the item to your next VAT 
return. QuickBooks automatically picks up every transaction that 
doesn’t have a ‘filed’ flag in the following tax period. 

To complete a Standard VAT scheme return:

Back up your company file. 

From the Suppliers menu, choose VAT, then File VAT. The File VAT 
window opens. 

In Show VAT through, select the last day of the tax period for which 
you are filing. 

In the Pay column, select the VAT return that you are filing. If you 
want QuickBooks to print a cheque for you, click To be printed. If 
you want to write the cheque yourself, click Assign cheque no. 

Click Next. Your VAT return is created. Review your return. Scroll to 
the bottom and click Next. 

Click Print and use this report to help fill out an official form for HM 
Revenue & Customs. (Keep the report you just printed for your 
records.) Click Done to close the report.

Write your cheque to the HM Revenue & Customs, or if QuickBooks 
is printing the cheque for you, follow the steps below:
a. From the File menu, select Print Forms, then choose Cheques. 
b. Select the cheque to the HM Revenue & Customs and click OK. 
c. Set your printing options, then click Print. 

Send in your VAT return. You have to file a return even if your VAT is 
nil. 

The Payment 
Date is the 
date this 
transaction will 
be recorded to 
the VAT Control 
account, and 
affect your 
bank account.
49



50
Completing a Cash Accounting scheme return

If you are using the Cash Accounting scheme, you are liable for VAT only on invoices 
where you have received the cash from your customers, and invoices from your 
suppliers that you have already paid. 

To complete a Cash VAT Scheme return:

Back up your company file. 

Go to the Reports menu, select VAT, then VAT Detail.

QuickBooks produces two reports: Cash VAT and Cash Net. Make sure that the 
word Cash is in the title of the report. Print these reports and keep them for your 
records in case you get audited.

Now print the VAT 100 report. Go to the Reports menu, select VAT, then VAT 100. 
Use this report to help fill out an official form for the HM Revenue & Customs. 

Using the VAT 100 report, write your cheque to the HM Revenue & Customs.
a. From the File menu, select Print Forms, then choose Cheques. 
b. Select the cheque to the HM Revenue & Customs and click OK. 
c. Set your printing options, then click Print. 

For complete instructions on filing your VAT, refer to the in-product Help. Go to the 
Find window and search for “filing your VAT return”. 

You can also find more information in the User Guide. To open the User Guide, go to 
the Help menu, select QuickBooks Guides, then User Guide.

This report lists all your 
sales (outputs) and 
purchases (inputs) 
without VAT during the 
reporting period. 

This report lists the VAT 
amount on all your sales 
(outputs) and purchases 
(inputs) during the 
reporting period. 
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Paying employees is a big responsibility. You have to calculate gross and net pay, tax, 
NICs, statutory payments and pension scheme deductions, as well as track the liability 
payments you need to send to your tax office and benefit agencies. 

QuickBooks Small Business Payroll

With a subscription to QuickBooks Payroll, you have 
access to several features and services to help you 
process your payroll without having to understand 
payroll legislation. No more manual calculations, or 
having to keep track of changes that are made to the 
tax tables. QuickBooks takes care of your payroll so you 

have more time to spend on your business! And, QuickBooks Payroll 2006 is now 
accredited as fully meeting the HMRC Payroll Standard. 

How do I subscribe to the QuickBooks Payroll Service?

Subscribing to QuickBooks Payroll is easy. Open up your QuickBooks software and go to 
the Employees menu; choose Payroll Service, and click the Subscribe button. You will not 
have to install any addition software, as it’s already installed for you. To learn more about 
this service, go to the Employees menu and select About Payroll Service.

Once subscribed, QuickBooks unlocks all your payroll features along with all the latest tax 
tables. You’ll also receive software updates throughout the year which may include new 
features, software enhancements, and/or help updates.

To update your tax tables:

Open QuickBooks and make sure you are connected to the Internet.

From the File menu, choose Update QuickBooks. 

Click Update Now. 

Select the updates you want to download, then click Get Updates.

When the update is done, click Close and restart your computer.

You can see what tax table version you currently have installed by going to the 
Employees menu and selecting Payroll Service. The version number of the tax table 
QuickBooks is currently using is listed in the Tax Table Information section. To see the 
legislation changes implemented for that tax table, click the Tax Table Info button. 

Tip  You can have QuickBooks automatically download new tax tables when they 
become available by turning on the Automatic Update feature. Refer to the in-product 
Help for more information. Go to the Find window, and search for “automatic update”.
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Key Terms

Earnings base

Earnings basis is the 
wages or earnings due to 
an employee before any 
deductions are made. It is 
also referred to as gross 
pay, taxable income, gross 
taxable pay to date, or (for 
NI purposes) insurable or 
Ni-able earnings. An 
employee’s earnings base 
or gross pay can include 
wages, salaries, overtime, 
bonuses and commission. 
QuickBooks uses the 
earnings basis (or gross 
pay) to work out payroll 
withholding amounts such 
as income tax or National 
Insurance contributions.
The earnings basis for 
income tax is what remains 
of the employee’s pay after 
pre-tax deductions such as 
Approved Pension Plan 
contributions, Additional 
Voluntary Contributions, 
and Give As You Earn 
amounts have been taken. 
The earnings basis for 
National Insurance is what 
remains of the employee’s 
pay after pre-NI deductions, 
if any, have been taken. In 
QuickBooks, the earnings 
basis for an NI payroll item 
is nearly always the same 
as the employee’s total 
pay to date. 
Collecting Information You Need to Set Up 
Payroll

Setting up your payroll data in QuickBooks can be a daunting task that 
can often take a long time to complete depending on the size of your 
company. This process will go more smoothly if you gather your payroll 
data before you begin setting it up in your software. Use the table 
below as a guide to the information that you will need when setting up 
your payroll in QuickBooks.

Information QuickBooks needs... Where to find it...

Tax office number and reference
P11 Working Sheet, your accountant 
or company records

Current tax tables covering payroll 
withholdings such as National 
Insurance Contributions and income 
tax rates

QuickBooks downloads them 
automatically for you when you are 
subscribed to the Payroll Service. 
Alternately, you can order a payroll 
update CD from us

How you pay your employees and 
directors (hourly wages, salaries, 
and/or commissions)

P11 Working Sheet, your accountant 
or company records

How often you pay your employees
P11 Working Sheet, your accountant 
or company records

Additions you make to your 
employees’ pay that increases their 
earnings base (bonus payments, 
statutory payments, etc.)

P11 Working Sheet, your accountant 
or company records

Deductions you make to your 
employee’s pay (pension schemes, 
student loan repayments, union 
dues, holiday pay schemes 
Attachment of Earnings Orders, etc.)

P11 Working Sheet, your accountant 
or company records

Payroll expenses that your company 
pays (employee pension schemes, 
health or life insurance)

P11 Working Sheet, your accountant 
or company records

Information for company directors. 
Do you calculate NICs based on the 
annual (or pro-rate annual) method 
or per period (weekly, monthly)

P11 Working Sheet, company 
records, employee, payslips, 
employee contracts

Table continued on next page...
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Information QuickBooks needs... Where to find it...

Employee personal information 
(National Insurance number, date of 
birth, contact details)

P11 Working Sheet, your employee or 
company records

Employees rate of pay and payroll 
payment additions, deductions and 
employer contribution amounts 

Payslips, company records, employee 
contracts or your accountant

Previous employment information for 
employees who joined your company 
mid-way through the current tax year 
(National Insurance, tax codes and 
Scheme Contracting Out Number 
(SCON) for employees who opted out 
of State Earnings Related Pension 
Scheme (SERPS))

P45 or P46, SSP1(L), previous employer, 
your accountant or company records

If paying by BACs, employee’s bank or 
building society details (sort code, 
account number, name of account 
holder, bank name and address, and 
roll number if the account is with a 
building society)

Employees, your accountant or company 
records

Statutory payment information for 
existing or future SSP, SMP, SPP, or 
SAP including working day patterns

SSP1(L), BF 220/220A/220B/220C, 
MATB1, your accountant or company 
records

Holiday and sick time accruing 
policies and amounts

Payslips, your accountant or company 
records

Total employee payroll amounts that 
you’ve paid out so far this payroll year 
up to the date you start using 
QuickBooks including amounts 
withheld from payroll payments 

Copies of employee payroll payments, 
payslips, previous accounting software 
or service provider, reports, your 
accountant or company records 

If you are operating payroll, total 
amount of PAYE income tax and 
National Insurance (NI) contributions 
are owed to the HMRC as of your 
start date.

Previous accounting software or service 
provider, accountant or company records
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Key Terms

Payroll Liabilities 

account

The Payroll Liabilities 
account tracks taxes that 
you deduct from 
employees' payroll 
payments and holds them 
temporarily until you remit 
them to the government. 
These include income tax 
and National Insurance 
Contributions. 
QuickBooks automatically 
adds this account to your 
chart of accounts. When 
you create payroll items, 
QuickBooks automatically 
assigns some of them to 
the Payroll Liabilities 
account by default (but you 
can change this 
assignment if you prefer to 
assign them to a different 
account). When you change 
a payroll item to track to a 
different account, the 
change affects all (previous 
and current) payroll 
cheques that have the 
newly-changed payroll item 
attached to it.

Payroll Expenses 

account

The Payroll Expenses 
account tracks payroll 
items that are an expense 
to your company. These 
include salaries, wages, 
bonuses, commissions, 
and the company-paid 
portion of taxes such as 
Employment Insurance.
QuickBooks automatically 
adds this account to your 
chart of accounts. When 
you create payroll items, 
QuickBooks automatically 
assigns some of them to 
the Payroll Expenses 
account by default (but you 
can change this 
assignment if you prefer to 
assign them to a different 
account).
Adding Payroll Items

You add payroll items to payroll payments the same way you add items 
to invoices. Payroll items track amounts such as wages you pay and 
taxes you deduct from your employees. There are payroll items for 
commission, taxes, NICs, other additions and deductions (such as 
student loans and AEOs), and employer-paid expenses. You can assign 
these payroll items to different accounts as needed.

By default, QuickBooks creates some of the more common payroll 
items that you’ll need to process your payroll such as statutory 
payments, tax deductions, pension schemes, AEOs and student loan 
repayments to name a few. However, you may find that you’ll need to 
add payroll items to suit your own needs. For example, you may need 
to add a payroll item for health insurance that your company provides 
to employees.

When you need to create new payroll items, you’ll use the payroll item 
wizard which will guide you through the set up (as long as your 
QuickBooks Payroll Service subscription is up to date).

To create a payroll item:

From the Employees menu, choose Payroll Item List.

From the Payroll Item menu button, choose New. The payroll item 
wizard opens.

Choose the type of payroll item you want to create.

Click Next and answer the questions on each slide of the wizard.

Use this payroll item To track

Wage
Money you pay to employees for salaries, 
hourly wages and commissions.

Addition
Money you pay to an employee that increases 
his or her earnings base such as a bonus.

Deduction
Money you deduct from your employee other 
than taxes, such as pension schemes.

Employer Contribution
Employer-paid benefits for your employees 
such as life insurance or employer 
contributions to a pension scheme.

Attachment of 
Earnings Order (AOE)

Money that a court or local authority orders 
you to deduct from an employee to pay back 
his or her debt.
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Key Term

Directors

A director is a person who, 
traditionally, manages the 
business of the company 
on a day-to-day basis. With 
QuickBooks, you have the 
flexibility to calculate your 
director’s NICs annually or 
on a per period basis. For 
more information on 
directors, refer to the in-
product Help. Go to the 
Find window and search for 
“directors”.

Did you Know?

Information that is 
common to most of your 
employees can be set up 
as a default. That way, 
when you go to set up an 
employee, some of the 
payroll settings are already 
set up for you. For more 
information on setting 
employee defaults, refer to 
the in-product Help. Go to 
the Find window and 
search for “entering 
common employee 
information”.

Learn More

To learn more on Managing 
Employees, go to the Find 
window and type in the 
following terms to search 
for these help topics:

Changing payroll 
information for an 
employee

Entering year-to-date 
amounts for an 
employee

E-payment solutions for 
payroll

Releasing an employee
Paying statutory pay
Payroll overview
Setting Up Employees

To process payroll payments and prepare tax documents for your 
employees and directors, you first need to create an employee profile 
or record that keeps track of the employee’s personal details, tax and 
payroll information. The information from the employee profile is used 
to create his or her payments. 

Creating employee profiles or records

To set up an employee’s personal information: 

From the Lists menu, choose Employee List.

From the Employees menu button, click New. 

Complete the Address Info tab (contact number, NI number, DOB, 
etc.).

(Optional) On the Additional Info tab, define custom fields to store 
other information such as an emergency contact number.

To set up an employee’s payroll information:

Open the New Employee window as described in the steps above. 
Change the tab to Payroll and Compensation Info.

In the Earnings section, set up the details of the employee’s pay. 
• Under Item Name, select the type of payment (hourly or salary).
• Under Hourly/Annual Rate, enter the amount of the pay. 
• Choose the pay frequency (how often you pay this employee).
• Choose the pay method (do you use cash, cheques or BACS).

If you use QuickBooks to track your employee’s time and payment 
based on this time, select “Use time data to create payments”. 

In the Other Payroll Items section, set up additions, deductions and 
employer contributions (except for taxes) that affect the employee’s 
pay (eg., bonuses and pension schemes).

Click Sick/Holiday to set up how sick time and holidays are 
accrued. 

Click Tax/NI Details to enter tax and NI code information.

If you pay the employee with BACS, click Bank Details to set up an 
employee’s bank account information.

If the employee started employment with you part way through the 
current tax year, click Previous Employment to enter the total 
amount of pay and taxes paid while he or she worked for the 
previous employer. This information is available from the P45 and 
SSP1(L) forms.
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Entering year-to-date amounts for your employees
If you began using QuickBooks Payroll part way through the current tax year, you 
must enter year-to-date amounts for each employee that you’ve paid thus far in tax 
year. This is because PAYE is calculated on a cumulative basis, so QuickBooks 
needs to take into account an employee’s total pay and tax amounts for a given tax 
year in order to be able to deduct the right amount of tax from his or her pay. You can 
use the Year-to-Date wizard to help you enter year-to-date amounts for your 
employees.

Note: If you have an employee who begins working for you part way through the tax year, do 
not use the Year-to-Date wizard to add employment figures from his or her previous 
employer. Instead, add the figures from the P45 to his or her employee profile. (With the 
employee profile (record) open, go to the Payroll and Compensation Info tab and click the 
Previous Employment button.)

To enter year-to-date amounts for each employee:

Summarise the payroll payments you processed for each employee from 6 April to 
the date that you started using QuickBooks Payroll.

From the Employees menu, choose Set Up YTD Amounts. The YTD wizard opens.

Follow the on-screen instructions until you get to the Employee summary 
information screen. Select an employee from the list and click Enter Summary. 
The YTD Adjustment window opens.

Enter the details of the year-to-date payroll amounts for this employee. We 
recommend that you create one entry to summarise the payroll payments that 
you’ve paid to this employee thus far. You cannot do this, however, if an 
employee’s NI code changed throughout the tax year. An entry must be created 
for each payroll period where a new NI code was given. 

Click OK, and select the next employee. 

Click Leave when you are done, or if you need to enter prior payroll liability 
payments, click Next and refer to the steps below.

To learn more about entering year-to-date amounts, refer to the in--product Help. Go 
to the Find window and search for “entering employee year-to-date amounts during 
payroll setup”. 

To enter prior payroll liability payments:

Open the YTD wizard as explained in the steps above.

Follow the on-screen instructions until you get to the Enter prior payments screen. 

Click the Create Payment button to enter a summary of all the payments you’ve 
made to the government and other agencies from 6 April to the date you 
subscribed to QuickBooks Payroll.

How do I know which accounts are affected?  Look to the side bar area on the next 
page for more information on knowing when your accounts should be affected by 
year-to-date entries.
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Did You Know?

Accounts affected?

When you create year-to-
date entries, should the 
entries affect your 
accounts? Generally 
speaking, no. QuickBooks 
uses the date you selected 
in the YTD wizard to 
determine whether it 
should also adjust your 
expense, liability and bank 
accounts and most of the 
time, these accounts 
shouldn’t be adjusted.
In other words, if your 
payroll expense, liabilities 
and bank account balances 
are up to date, then your 
year-to-date entries should 
not affect your accounts.
If your payroll accounts are 
not up to date when you 
enter year-to-date figures, 
then you may want the YTD 
wizard to adjust their 
balances. Consult with your 
bookkeeper or accountant 
if this is the case. 
For more details on this, 
click the Help button on the 
Affect Accounts window. 
You can get to the Affect 
Accounts window by 
pressing the Accounts 
Affected button in the YTD 
wizard.

Week 1/month 1 basis

PAYE is normally calculated 
on a cumulative basis. 
However, there may be 
times when you need to 
calculate an employee’s 
income tax in a non-
cumulative way. This is 
referred to as a week 1 or 
month 1 basis. To create 
payments on a week 1/
month 1 basis, change the 
employee’s tax code by 
appending an X to it. 
QuickBooks then knows to 
work out the employee’s 
tax on a week 1/month 1 
basis. 
Managing statutory payments
There are times when you’ll have to make statutory payments to your 
employees who have stopped working for you because they became ill 
or are expecting a child. With QuickBooks Payroll, you can 
automatically calculate the payment of SSP, SMP and SPP for those 
employees who qualify. QuickBooks also tracks the amount of recovery 
you can claim and deducts it from your payroll liabilities account 
accordingly. 

Note: SAP can be set up in QuickBooks as well. However, QuickBooks does 
not calculate the SAP amounts for you. For more information on managing 
SAP, refer to the in-product Help and search for “SAP”.

To set up statutory payment details:

From the Employees menu, select Employee List.

Select the employee who requires a statutory payment, then click 
the Employee menu button and select Edit.

Change the tab to Statutory Pay Info and add the details of the 
scheme.

Operating your pension schemes

Pension schemes are managed using payroll items. You can set up a 
pension payroll item as a flat rate or a percentage of the employee’s 
pay. Depending on your payroll system, you may need to create two 
payroll items to process your pension schemes: one as a deduction 
from the employee’s pay (if needed), and the other as an employer 
contribution. 

Pension scheme payroll items can then be added to the employee’s 
profile or record. Once there, QuickBooks automatically calculates 
pension contributions when you create his or her pay. 

You can also create a payroll pension report to see a list of all the 
pension contributions that you and your employees have made. Go to 
Reports menu, select Employees & Payroll, then click Payroll Pension 
Detail.

Dealing with Attachment of Earnings Orders (AEO)

QuickBooks handles all types of attachments of earnings (AEOs). You 
set them up by creating an AEO payroll item and entering the court 
order information to the employee’s profile. The attachment amount is 
then deducted each pay period until the order has been paid. 

When it comes time to remit the attachment deductions, use the Pay 
Attachments and Print Liability Voucher features. 

To learn more about setting up AEOs, refer to the in--product Help. Go 
to the Find window and search for “Attachment of Earnings Orders”. 
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Did You Know?

Tax codes

In most cases, when you 
hire a new employee, you 
will get their tax code from 
the P45. If the employee 
doesn’t have a form P45, 
you may have to use an 
emergency tax code (BR 
tax code) until you get their 
tax code information. If you 
use an emergency tax 
code, don’t forget to 
submit a form P46 to the 
HM Revenue & Customs. 
Entering the right tax code 
is important as it ensures 
that QuickBooks is 
calculating payroll 
deductions correctly, and 
the P11 is properly filled 
out. Some common tax 
codes include suffix codes 
(489L), prefix codes 
(K100, D0), BR (Basic Rate 
22%) and NT (No Tax 0%).

Learn More

To learn more on Paying 
Employees, go to the Find 
window and type in the 
following terms to search 
for these help topics:

Entering wage and 
salary information

Overview of advance 
holiday payments

Payroll overview
Printing payroll cheques
QuickBooks payroll 

service
QuickBooks epayment 

solutions for payroll
Reports about 

employees and 
payroll

Reviewing and adjusting 
payroll payments

Setting payroll printing 
preferences

Setting up time tracking 
for employees
Paying Employees

Your employees can be paid weekly, fortnightly, four weekly or monthly, 
and you can create their payments using cash, cheques or BACS. The 
employee’s tax and NICs are calculated automatically using the tax 
code and NI letter that you entered in the employee’s profile.

Note: Before you begin paying your employees, ensure that your payroll is set 
up completely and correctly in QuickBooks. We strongly recommend that you 
read the entire Payroll and Employees chapter in the QuickBooks User Guide. 
To read this guide, go to the Help menu, select QuickBooks Guides, and then 
User Guide.

To create payroll payments:

From the Employees menu, choose Pay Employees.

Choose the bank account you want to use to pay the employee(s).

Choose how the payroll payment is to be administered.
• If you print the pay cheques, tick “To be printed”
• If you pay via BACS, in the BACS Agency Payee field, select the 

agency you use to administer your BACS

In the Payment Date field, enter the date of this payroll payment. 
Basically, this is the date that the money will be received by the 
employee.

If you have many employees, use the filters to display a certain set 
of employees (eg. you may want to display only your weekly-paid 
employees). 

If you want to review or modify a payroll payment, select “Enter 
hours and preview payment before creating.” 

If you don’t need to review the payroll payment, select “Create 
payment without preview using hours below and last quantities.” 
QuickBooks will create the payment using the number of hours 
worked from the last payroll payment that you created for that 
employee.

Click Create.

If you chose to preview the payroll payment, QuickBooks displays 
the Preview Payment window, starting with the first employee you 
are paying. Make the changes to the payment and click Create. 

When you are done reviewing your payroll payments, click Print Pay 
Cheques to print the payroll cheques you just created, or...

Click Print Pay Slips. For more information on BACS, refer to the in--
product Help. Go to the Find window and search for “QuickBooks e-
payment solutions for payroll”.
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Making a Payment to the HMRC

Paying your payroll liabilities is easy with QuickBooks Payroll. QuickBooks 
automatically tracks how much you owe and to whom, allows you to choose which 
liability you want to pay, reduces your payroll liability where recovery amounts are 
concerned, and creates the cheques for you. 

Your biggest payroll liability will be owed to HMRC for income tax, National Insurance 
Contributions and student loan deductions that are withheld from employees. Each 
tax period (either monthly or quarterly), you must send a payment to the HMRC.

The method you use to send in your payment to HMRC determines the due date (you 
can send a payment electronically or through the post). Check with the HMRC or your 
accountant if you are unsure of when your payment needs to reach the Accounts 
Office.

To make a payment to the HMRC:

Note: When making a payment to HMRC, always use the Pay Payroll Liabilities feature as 
described below. Your payroll liability accounts will not be adjusted properly if you don’t use 
this feature and your liability reports will be incorrect.

From the Employees menu, choose Process Payroll Liabilities, then Pay Payroll 
Liabilities.

In the Through date field, enter the last day of the tax period for which you are 
paying your liabilities (this is the 5th of the following month), and click OK. You do 
not need to change the date in the From field. Even though it is set to April 6th (the 
beginning of the tax year), QuickBooks knows to only include your outstanding 
payroll liabilities for the current tax period for which you are paying.

If you qualify for SER, make sure to tick the small employer’s relief check box. 
QuickBooks uses a different recovery calculation for SER.

Note: QuickBooks will automatically make a statutory payment recovery adjustment that 
reduces your total liability amount if statutory payments were made during the tax 
period for which you are remitting a payment.

Tick the payroll items that are payable to the HM Revenue & Customs. Once you 
click one item, all other HM Revenue & Customs items are selected.

Use the information on the Pay Liabilities screen to fill in your payslip (P30).

Note: If you created SMP, SPP, or SAP payments during a given tax period and you 
qualify for SER, you can create the Statutory Payments report to help fill in your P30 
payslip. This report breaks out the NIC recovery amount from the total which is required 
for the P30. To create this report, go to the Reports menu, choose Employee & Payroll, 
then click Statutory Payments Detail.

Click the Create button once you have completed the P30. QuickBooks creates 
the cheque for you and adjusts your payroll liability accounts accordingly. 

Send your payment and the payslip to your Accounts Office. To learn more about 
sending your payment electronically, click the Electronic Payment link shown on 
the Pay Liabilities screen. 
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Key term

Payroll Liabilities

Payroll liabilities are the 
amounts that you have 
deducted from your 
employees’ pay but not yet 
passed on to the 
government or other 
agencies.
QuickBooks tracks the 
amount you owe for your 
payroll liabilities in an 
account called “Payroll 
Liabilities” which is 
automatically created. 
Each time you create a 
payroll payment, 
QuickBooks increases the 
balance of this liability 
account, and when you pay 
your payroll liabilities, the 
balance of this account is 
decreased. QuickBooks 
also adjusts your payroll 
liability if you are entitled to 
any recovery amounts (eg. 
statutory recovery).

Learn More

To learn more on Managing 
Payroll, go to the Find 
window and type in the 
following terms to search 
for these help topics:

Adjusting your payroll 
liabilities

Filling in a P32
How QuickBooks 

calculates payroll 
liabilities

Paying payroll taxes and 
other liabilities

Payroll overview
Preparing and filing 

payroll tax forms
Recording a payroll 

liability refund cheque
Setting up and using 

QuickBooks payroll
Verifying payroll 

liabilities
Forms to Help Manage Your Payroll 
(P11 & P45)

Deductions Working Sheet P11

QuickBooks Payroll creates and maintains an electronic version of the 
P11 form for each of your employees. Every time you pay an employee, 
the details of the pay are recorded to the P11. It is good practise to 
review the figures on the P11 after each payroll period. It will make your 
payroll year end reporting run more smoothly.

To view an employee’s P11:

From the Employees menu, choose P11 Working Sheet.

Select the employee and click OK.

QuickBooks displays the employee’s P11 for the current tax year. 
To see a P11 for a different year, go the Tax Year field and select 
the year you want. QuickBooks breaks the form down in to four 
sections: NIC details, NIC summary, PAYE details, and PAYE 
summary. To see data for a particular section, click its link at the 
top or bottom of the form.

Form P45

If an employee leaves your company, QuickBooks can print a P45 form 
for the leaver.

To print a P45 for a leaver:

Create the final payment for the employee who is leaving.

Load the P45 form in to your printer.

Open the Employee’s profile or record and enter his or her leaving 
date.
• From the Employees menu, select Employee list.
• Select the leaving employee and click the Employee menu button. 
• Go to the Personal Info tab and in the Left field enter the date 

that the employee is leaving.

From the Employees menu, select P45 for Leavers. 

Select the leaving employee.

Click Print P45. 

Give Parts 1A, 2 and 3 of the form to your employee, and send Part 
1 to the HM Revenue & Customs.
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screen (pictured below). It will guide you through the steps you must complete when 
processing your payroll year end, and help you to produce the year-end forms that you 
need to submit for your employers annual return. Also, use the checklist on this page to 
help you with your year end.

Once you have reviewed and printed your end-of-year forms, you can use QuickBooks 
Payroll to file your P35 and P14s electronically. If you are a business with less than 50 
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payment from the government.

Payroll Year End Checklist

❑ Run and update your final payroll period

❑ Process any leavers

❑
Check to see that you have enough pre-printed year-end forms; If filing your 
return online, get your User ID and password ready

❑ Print your P11 working sheets for your records

❑ Print your P14/P60s

❑ Print your P35 and check it against your P14s

❑ Print your SSP, SMP, SAP and SPP reports

❑ Distribute P60s to employees who are still employed by you at 5 April

❑ Send your end-of-year forms to the HMRC
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Did You Know?

Filing your return online

With QuickBooks Payroll, 
you can send your return to 
the HMRC using the 
Internet (this is called 
efiling). Businesses with 
less than 50 employees 
receive tax-free financial 
incentives if they submit 
their end-of-year returns 
online. To efile your return, 
you must first register with 
HMRC for “PAYE Online for 
Employers”, and have a 
valid User ID and 
password.
When you efile using 
QuickBooks, it sends your 
P14 and P35 forms to the 
HMRC over the Internet. 
You will receive a message 
indicating whether the 
submission was successful 
or not. If the transmission 
was unsuccessful, the 
message will tell you what 
is wrong. You’ll need to fix 
the data before you try to 
efile again.
Once you have successful 
efiled your return, you 
cannot efile again. 
Therefore, it is important to 
ensure that your end-of-
year forms are correct. If 
you need to amend your 
P14 and P35 forms after 
you’ve successfully efiled 
your return, you must send 
the amendments using 
paper forms. Keep a paper 
trail of your amendments in 
case you get audited in the 
next three years.
Filing Your Payroll Year-End Forms

At the end of the year, you must create forms P14/P60s and a P35. 
The Payroll Year End Process screen guides you through this task. Use 
it to
• review and print P14/P60 forms
• review and print the P35 form
• file your P14s and P35 online (electronically)

To print and file your end-of-year forms (P14s/P60s & P35):

You must complete these steps in their proper order. QuickBooks 
warns you if you try to complete a step out of sequence. When all the 
steps are completed, QuickBooks allows you to efile your end-of-year 
forms.

From the Employees menu, select Process Payroll Year End.

Choose the payroll year for which you are completing a return. 

Mark all the employees that worked for you in the year.

Review your P14/P60 forms. Click Review P14/P60 Data. 
A P14 for the first employee is shown. Review the data and click 
Next until you have reviewed all P14/P60s.

Print your P14/P60s.
• Insert a laser, portrait-style blank form in your printer.
• Click Print P14/P60 Forms. Depending on your year end process, 

you may need to repeat this step until you have printed all the 
forms.

Review your P35. Click Review P35 data.
QuickBooks generates your P35 based on data from your P14/
P60s. The form is broken down in to four sections or tabs. Review 
the data on each tab, then click OK when you are sure that the 
figures are accurate.

Click Checklist & Declaration and answer all the questions listed. 

Print your P35. Click Print P35.
Although the P35 that QuickBooks prints looks like the official 
HMRC form, it is only for your records. If you are sending your return 
in the post, you must transfer the data from the printed form to an 
official one.

File your annual return. Before you do so, make sure your P35 and 
P14 data is correct and that you have created a backup of your 
company file.

Instructions continued on next page...
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If you are filing a paper return...  Use the data from the P35 you just printed to fill 
in the HMRC official form and send it to the HMRC along with your P14s. Keep a 
copy of the forms for your records.

If you are efiling your return...  Click the File Online button. Fill in the Employer 
Data, Online Filing Access and Employer and Agent Contact Information as 
applicable. You will need your User ID and password that you received from HMRC 
to send your return electronically.

Important Payroll Year-End Dates

5th April Payroll or tax year end

6th April Payroll or tax year begins

19th April
Last day for outstanding PAYE and Class 1 NICs to reach 
HMRC (if you pay with an electronic payment, you can 
extend this deadline to 22 April)

19th May
P35s and P14s to be submitted to the HM Revenue & 
Customs

31th May P60s given to employees no later than this date

6th July
P9D and P11D forms to the HM Revenue & Customs no 
later than this date

19th July
Payment of Class 1A NIC on P11D benefits in kind 
(if you pay with an electronic payment, you can extend 
this deadline to 22 July)



Index

Numerics
5-user pack, installing 5

A
accountants (see Professional Advisor) 26
accounts

adding 34
balance sheet 36
deciding which type to use 36
defined 35
income and expense 37
payroll expenses, defined 55
payroll liabilities, defined 55
subaccounts 35
undeposited funds 37

accounts payable, defined 29
activating

having trouble with 9
QuickBooks 18

adding
accounts 34
customers 38
employees 56
icons to the Icon Bar 22
items 42
jobs 39
payroll items 55
suppliers 40

AEO 59
assets, defined 13
assisted support

calling product support 26
support services 26
working with a Professional Advisor 26

Attachment of Earnings Order 59

B
backing up

file format 11
previous accounting system 7

BACS, paying employees with 61
balance sheet accounts, described 36
bank accounts, setting up 16
bills

paying 29

C
calling product support 26
Cash Accounting scheme 47
chart of accounts, defined 35
checklist

getting started 12
information to collect for payroll 53
payroll year end 64

client-server network, requirements 6
closing Follow-Me Help windows 23
common tasks

adding accounts 34
adding customers 38
adding items 42
adding suppliers 40

paying employees 60, 61
preparing payroll forms 62
setting QuickBooks preferences 32
tracking VAT 46
updating tax tables 52
year end 64

company file
defined 12, 13
finding out the size of 9
setting up 12, 13
sharing 5
using more than one 9

company preferences
defined 33

computer equipment requirements 4
contact manager

synchronising with 17
contacting Intuit 26
creating

accounts 34
company file 14
customers 38
employees 56
items 42
P11 form 63
P45 63
payroll items 55
suppliers 40

Customer Manager
compatibility with QuickBooks 5

Customer Services
free 30 days support 26

customers
adding 38
defined 39
importing from other applications 17
tracking jobs for 39
with special VAT status 47

customising 22
Icon Bar 22
QuickBooks 33
QuickBooks desktop 21

D
deductions working sheet P11 63
default settings for employees 57
Dell PCs, trouble with installing updates 9
desktop, customising 21
directors, defined 57
displaying

Follow-Me Help 23
one window at a time 22

E
earnings base, defined 53
EasyStep Interview, using 14
employee

week 1/month 1 59
employees

Attachment of Earnings Order 59
creating P60s for 65
67



68
directors, defined 57
earnings base, defined 53
paying 60, 61
pension schemes for 59
printing payroll cheques/payslips for 61
setting defaults for 57
setting up 56
setting working patterns for 56
tax codes for 61

end of year, completing 64
error messages

finding meaning of 7, 9
expense accounts

described 37
displaying balances for 37

exporting data 11

F
FAQ knowledge base, using 25
filing your return online 65
filing your VAT 48
finding

answers to your questions 23
installation key code 7

Follow-Me Help
closing down 23
using 23

forms
P11 63
P14/P60 65
P35 65
P45 63
payslips 61
sending online 65

G
getting started checklist 12

H
hardware requirements 4
Help resources

closing Follow-Me Help 23
FAQ knowledge base 25
Follow-Me Help 23
free 30 days support 26
in-product Help 23

Help system
described 23
getting step-by-step instructions 24
using Search 25
using the Index 24

hiding items from the list 43
historical transactions, entering 15
HMRC, paying 62

I
Icon Bar 22
important payroll dates 66
importing customer information 17
importing data 11
importing supplier information 17
improving QuickBooks performance 5

inactive items 43
income accounts

described 37
displaying balances for 37

index, using 24
in-product help 23
installation key code

finding 7
installing

5-user pack 5
from a server or shared device 5
QuickBooks 7
troubleshooting 10

Internet Explorer
disk space required 4

Intuit, contacting us 26
items

adding 42
choosing the type to use 44
defined 43
for payroll 55
hiding from the list 43
importing from other applications 17
setting up to charge VAT 48
using different units 45

K
keyboard shortcuts 15, 71, 72
knowledge base, defined 25

L
License Number, locating 9
lists

entering information as you work 29
finding out the size of your company file 9
how they work in QuickBooks 27

M
memory required to run QuickBooks 4
Microsoft Excel

integrating with QuickBooks 5
Microsoft Outlook

integrating with QuickBooks 5
synchronising with 17

Microsoft Word
integrating with QuickBooks 5

multiple windows, viewing 22
multi-user licence, installing 5
multi-user mode

improving performance 5
requirements 5
setting up for 8

N
networks, setting up QuickBooks on 8

O
online, filing 65

P
P11 63



Index
P14 65
P35 65
P45 63
P60 65
passwords

importance of 8
troubleshooting 10
using 7

patches, downloading and installing 8
paying bills

versus writing cheques 29
what happens behind the scenes 29

paying, employees 60, 61
payroll

adding payroll items 55
Attachment of Earnings 59
checklist for year end 64
directors, defined 57
earnings base, defined 53
employees, setting up 56
entering previous payroll liabilities 58
important dates 66
information you need to set up for 53
items for 55
P11 63
P45 63
paying liabilities 62
payroll expenses account, defined 55
payroll items 55
payroll liabilities account, defined 55
payroll service 52
pension schemes 59
printing payroll cheques/payslips 61
setting defaults for employees 57
setting up 52–66
setting working patterns 56
subscribing to 52
tax code for employees 61
types of payroll items 55
updating tax tables 52
week 1/month 1 59
year end checklist 64
year-end forms 65

payroll cheques, printing 61
payroll expenses account, defined 55
payroll items

creating 55
described 55
item types 55

payroll liabilities
bringing up-to-date 58
paying 62

payroll liabilities account, defined 55
payslips, printing 61
peer-to-peer network, requirements 6
pension schemes 59
performance, multi-user mode 5
phoning product support 26
preferences, defining 32, 33
printing payroll cheques/payslips 61
processing payroll liabilities 62
processor required to run QuickBooks 4

Product Information window 9
Product Number

locating 9
product support

calling 26
free 30 days support 26

Professional Advisor
getting help from 26

Q
Quick Add

described 29
using for customers 39
using for suppliers 41

QuickBooks
activating 18
backup file 11
customising 33
exporting data 11
finding out the size of file 9
free 30 days support 26
getting started checklist 12
how lists work 27
importing data into 11
installation key code 7
installing 7
installing different versions of 10
installing on multiple computers 11
installing updates 8
Payroll service 52
RAM required to run 4
required computer equipment 4
reverting to an earlier version of 10
setting up users in multi-user mode 8
setting up your company 12
starting 7
system requirements 4
trouble updating on Dell PCs 9
trouble with activating 9

QuickBooks desktop, customising 21
QuickBooks Payroll 52

updating tax tables 52
QuickBooks Payroll Service 52
QuickBooks Product Support, calling 26

R
RAM required to run QuickBooks 4
remitting payroll payments 62
remitting your VAT 48
requirements

client-server network 6
hardware and software 4
integration 5
multi-user mode 5
peer-to-peer network 6

returns
doing it online 65
VAT 48
year end 64
69



70
S
sample company files, described 25
schemes for VAT 47
Search

using effectively 25
security, using passwords 7, 8
server

installing from 5
service plan for Payroll 52
setting up company files 12, 13

bank account information 16
completing list information 15
completing setup 14
entering historical transactions 15
fine-tuning accounts 15

setting up payroll 52–66
employees 56
information to collect 53
payroll items 55
types of payroll items 55

setting up QuickBooks
getting started checklist 12
payroll 52
VAT 46

shortcuts 15, 71
software patches and updates

downloading 8
trouble installing on Dell PCs 9

software requirements 4
speeding up QuickBooks performance 5
Standard VAT Accounting scheme 47
start date

choosing 14
defined 12

stocking and selling in different units 45
subaccounts, described 35
subscribing to payroll 52
suppliers

adding 40
defined 41
HMRC 48, 62
importing from other applications 17

support services, described 26
Symantec ACT!

integrating with QuickBooks 5
synchronising with 17

system requirements 4

T
tax codes for employees 61
tax tables, updating 52
technical support

calling 26
described 26

technical support, calling 26
Timer, disk space required 4
tracking customer jobs 39
tracking VAT 46–49
troubleshooting

calling technical support 26
can’t activate QuickBooks 9
can’t find installation key code 9

can’t update QuickBooks on Dell PCs 9
free 30 days support 26
installation 10
installing different versions of QuickBooks 10
looking online for the answers 23
password not working 10
reverting to an earlier version of 

QuickBooks 10
using in-product help 23

types of accounts to use 36

U
undeposited funds account, described 37
units of measure, setting up 45
updating

problems with 10
QuickBooks 8
tax tables 52
trouble with on Dell PCs 9

user interface
modifying the Icon Bar 22
viewing multiple windows 22

user rights
Microsoft Windows 6

users, setting up in multi-user mode 8
Using the QuickBooks Payroll Service 52

V
VAT

filing a return 48
filing your return 48
liabilities 47
overview (picture) 46
remitting to HMRC 48
schemes 47
setting up customers with special VAT 

status 47
setting up items for 48
tracking 46–49
turning on 47

VAT codes list 48

W
week 1/month 1 59
windows

closing Follow-Me Help 23
displaying one at a time 22

working patterns for employees 56
working sheet P11 63
writing cheques versus paying bills 29

Y
year end 64

checklist for 64
creating forms for 65
filing online 65
important dates 66
P11 working sheet 63

YTD summaries for payroll liabilities 58



Keyboard Shortcuts

General Key

To start QuickBooks without a 
company file

Ctrl + 
doubleclick

To suppress the desktop windows
(at Open Company window)

Alt (while 
opening)

Display information about 
QuickBooks

F2

Cancel Esc

Record (when black border is 
around OK, Next, or Previous 
button)

Record (always) Ctrl + 

Dates Key

Next day + (plus key)

Previous day - (minus key)

Today T

First day of the Week W

Last day of the weeK K

First day of the Month M

Last day of the montH H

First day of the Year Y

Last day of the yeaR R

Date calendar
Alt + down 
arrow
Editing Key

Edit transaction selected in 
register

Ctrl + E

Delete character to right of 
insertion point

Del

Delete character to left of 
insertion point

Backspace

Delete line from detail area Ctrl + Del

Insert line in detail area Ctrl + Ins

Cut selected characters Ctrl + X

Copy selected characters Ctrl + C

Paste cut or copied characters Ctrl + V

Increase cheque or other form 
number by one

+ (plus key)

Decrease cheque or other form 
number by

- (minus key)

Undo changes made in field Ctrl + Z

Help window Key

Display Help in context F1

Select next option or topic Tab

Select previous option or topic Shift + Tab

Display selected topic

Close popup box Esc

Close Help window Esc
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Activity Key

Account list, display Ctrl + A

Cheque, write Ctrl + W

Copy transaction in register Ctrl + O

Customer:Job list, display Ctrl + J

Delete cheque, invoice, 
transaction, or item from list

Ctrl + D

Edit lists or registers Ctrl + E

QuickFill and Recall (type first 
few letters of name and press 
Tab, name fills in)

abc Tab

Find transaction Ctrl + F

Go to register of transfer account Ctrl + G

Help in context, display F1

History of A/R or A/P transaction Ctrl + H

Invoice, create Ctrl + I

List (for current field), display Ctrl + L

Memorise transaction or report Ctrl + M

Memorised transaction list, 
display

Ctrl + T

New invoice, bill, cheque or list 
item

Ctrl + N

Paste copied transaction 
in register

Ctrl + V

Print Ctrl + P

QuickZoom on report

QuickReport on transaction or 
list item

Ctrl + Q

Register, display Ctrl + R

Show list Ctrl + S

Use list item Ctrl + U

Transaction journal, display Ctrl + Y

Moving around a window Key

Next field Tab

Previous field Shift + Tab

Report column to the right Right arrow

Report column to the left Left arrow

Beginning of current field Home

End of current field End

Line below in detail area or 
on report

Down arrow

Line above in detail area or 
on report

Up arrow

Down one screen Page Down

Up one screen Page Up

Next word in field Ctrl + 

Previous word in field Ctrl + 

First item on list or previous 
month in register

Ctrl + Page 
Up

Last item on list or next 
month in register

Ctrl + Page 
Down

Close active window
Esc or Ctrl + 
F4
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